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[bookmark: _Toc179454096][bookmark: _Toc189750270]1.1 Latar Belakang Masalah
	Undang-Undang Nomor 20 Tahun 2003 menyatakan bahwa pendidikan adalah sebuah usaha sadar dan terstruktur guna mewujudkan suasana proses belajar dan pembelajaran agar siswa mampu mengembangkan potensinya untuk memiliki kemampuan keagamaan, kontrol diri, bermasyarakat, berbangsa dan negara (Tania, 2021). Peran pendidikan sendiri adalah dapat meningkatkan kualitas sumber daya manusia, mewujudkan kesejahteraan umum dan mencerdaskan kehidupan bangsa (Dalimunthe, 2021). Keberhasilan pendidikan melalui usaha-usaha belajar yang telah dilakukan, dapat dilihat dari tinggi atau rendahnya kualitas hasil belajar peserta didik (Sriana & Sujarwo, 2022). 




Pendidikan mencakup beberapa kajian tentang ilmu pengetahuan seperti ilmu pengetahuan alam, ilmu pengetahuan sosial serta ilmu matematika. Matematika adalah ilmu yang melekat di kehidupan dan bahasa yang digunakan pada penciptaan alam semesta adalah bahasa matematika (Soimah & Fitriana, 2020). Hasratuddin (2018) mengungkapkan bahwa matematika berasal dari bahasa Belanda yakni “wiskunde” diartikan ilmu pasti yang keseluruhannya berhubungan dengan penalaran serta pemberian alasan yang dapat dibuktikan. Menurut NCTM (The National Council of Teachers of Mathematics) yang menjadi standar proses tujuan pembelajaran matematika adalah belajar memecahkan masalah, bernalar, berkomunikasi, membentuk ide, serta melakukan representasi (Hakim, 2019). Dengan demikian matematika bisa dikatakan sebagai 
1

salah satu cabang ilmu yang  dapat menjadikan individu memiliki beberapa jenis kemampuan berpikir sekaligus sebagai modal dalam menjalani kehidupan dan bertujuan untuk memperoleh kemampuan berpikir, bernalar, serta berkomunikasi dengan baik kepada siapapun yang dihadapi. Mengingat bahwa pembelajaran matematika sangat berperan penting dalam membentuk kemampuan seseorang, untuk itu seorang pendidik harus mampu mengukur kemampuan matematika peserta didiknya dengan cara melakukan evaluasi pembelajaran agar dapat dijadikan sebagai dasar perbaikan serta pembaruan proses pembelajaran yang selama ini telah dilakukannya.
Evaluasi memiliki beberapa definisi yakni evaluasi adalah sebuah proses, tujuan evaluasi adalah mengetahui kualitas sesuatu, dan dalam mengevaluasi harus melalui proses pertimbangan (Yusuf, 2019). Pendapat lain mengatakan evaluasi memiliki tujuan guna mendapatkan informasi yang akurat tentang tingkat pencapaian dari tujuan pembelajaran oleh siswa yang mengakibatkan guru dapat mengetahui tindakan lanjutan apa yang harus dilakukannya dalam sebuah pembelajaran (Maliki & Erwinsyah, 2020). Evaluasi merupakan pengamatan langsung kepada siswa dengan melihat dari tingkah lakunya (Widiyarto & Inayati, 2023). Berdasarkan beberapa definisi diatas, dapat dikatakan bahwa evaluasi adalah sebuah kegiatan yang bertujuan untuk memperoleh pengetahuan tentang hasil proses pembelajaran yang telah diberikan kepada peserta didiknya. 
Mengevaluasi hasil belajar dapat dilakukan menggunakan dua cara yakni menggunakan tes dan non tes. Evaluasi bentuk tes yang dilakukan peneliti dengan cara memberi soal berupa pilihan ganda dan soal uraian untuk dikerjakan oleh siswa (Yuliawati et al., 2022). Pada umumnya tes dibuat dengan menggunakan tes tertulis. Tes tertulis tidak bisa dijadikan sebagai acuan untuk mengukur kemampuan peserta didik dalam memahami materi yang sudah diajarkan (Widiyarto & Inayati, 2023). Anas Sudijono mengungkapkan bahwa tes dikatakan berkualitas apabila mememenuhi beberapa aspek yakni validitas, reliabilitas, daya beda, tingkat kesukaran, serta efektifitas opasi (Sudijono, 2015). Dengan demikian tes merupakan salah satu alat yang dapat digunakan untuk mengukur kemampuan peserta didik tentang tingkat pemahaman materi yang sudah diterima dari guru yang mengajar yang harus memiliki kriteria valid, reliabel, daya beda, tingkat kesukaran serta opsi yang efektif. Sedangkan, teknik non tes menurut beberapa peneliti memiliki definisi yang cukup beragam. Anas Sudijono juga mengungkapkan teknik non tes biasanya menggunakan cara wawancara, pengamatan secara sistematis, pemberian angket atau mengamati dokumen yang ada. 
Evaluasi non tes dilakukan dengan cara wawancara, praktek ibadah, portofolio, serta observasi (Widiyarto & Inayati, 2023). Pendapat lain dikatakan instrumen non tes adalah suatu alat penilaian yang umumnya dipakai guna memperoleh suatu informasi tentang keadaan peserta didik dengan tidak menggunakan tes (Rufaedah & Himmawan, 2023). Non tes dilakukan menggunakan pengisian nilai sikap sosial, spiritual, interview kepada guru dan siswa, kegiatan observasi dan sebagainya (Yuliawati et al., 2022). Dengan demikian teknik non tes merupakan salah satu cara melakukan evaluasi pembelajaran dengan tidak menggunakan instrumen berupa soal tulisan. 
Dalam melakukan evaluasi pembelajaran khususnya pembelajaran matematika yang dilakukan oleh guru cukup banyak ditemukan kendala yang dirasa menyulitkan yang mengakibatkan tidak banyak dari para pendidik/guru yang ada melakukan kegiatan evaluasi mulai dari terkendala waktu, biaya, serta ketidakmampuannya guru melakukan evaluasi pembelajaran yang diinginkan hal ini senada dengan yang diungkapkan oleh beberapa peneliti sebagai berikut,  pendidik lebih memperhatikan proses pembelajaran dibandingkan dengan kegiatan evaluasi, ada pula pendidik yang tidak menghiraukan kegiatan evaluasi, yang penting ia masuk kelas, mengajar, dan pada akhir semester ia telah mencapai target kurikulum (Huljannah, 2021). Guru sangat jarang melakukan kegiatan analisis dan evaluasi karena selain tugas mengajar guru, guru juga melaksanakan tugas lain diluar tugas pokok sebagai guru (Tilaar et al., 2020). Selanjutnya, banyak guru masih menganggap kegiatan evaluasi merupakan hal yang tidak penting, titik fokusnya hanya terkait pada pemberian materi sebanyak-banyaknya. Selain itu, beberapa penelitian juga menunjukkan bahwa guru-guru sebagai pendidik, kurang memiliki kompetensi terkait konsep evaluasi juga konsep untuk melakukan evaluasi (Riadi; Sutrisno, 2022).
Saat penulis melakukan observasi, kegiatan analisis cukup jarang ditemui dan berdasarkan ungkapan dari guru yang diwawancarai mengatakan bahwa kegiatan analisis jarang dilakukan oleh guru disekolah dikarenakan kegiatan tersebut cukup rumit untuk dilakukan serta memakan waktu yang banyak hal tersebut jugalah yang menjadi latar belakang masalah dari penelitian-penelitian terdahulu yang telah dipaparkan diatas. Padahal jika melihat dari kebermanfaatan kegiatan evaluasi ini dapat dijadikan sebagai pedoman atau dasar oleh pendidik untuk melakukan perbaikan proses pengajaran serta tindak lanjut tentang apa yang harus dilakukan untuk meningkatkan kemampuan peserta didiknya. Keuntungan lain yang dapat diperoleh oleh pendidik jika melakukan kegiatan analisis adalah pendidik dapat mengetahui jenis tes apa yang cocok digunakan untuk menguji kemampuan pemahaman peserta didiknya. Hal tersebut tak lepas dari cukup banyaknya beban tugas administrasi yang telah diselesaikan dengan baik oleh guru seperti membuat Rencana Pelaksanaan Pembelajaran (RPP), Prota, Prosem, materi-materi pembahasan, serta soal-soal ulangan yang akan diujikan ke peserta didiknya. Selain memenuhi kebutuhan administrasi yang cukup banyak, guru juga memiliki peran penting lain dalam pelaksanaan pendidikan khususnya untuk peserta didiknya yakni membentuk masa depan generasi mendatang, memberikan inspirasi dan motivasi, menjadi model perilaku positif, memberikan dukungan emosional, menginspirasi keterlibatan dan kreativitas, mengembangkan keterampilan hidup, menciptakan lingkungan belajar yang aman dan positif, membangun hubungan yang kuat dengan siswa dan orang tua. Mengingat cukup banyaknya tugas dan tanggung jawab seorang guru hal tersebut banyak dari para guru tidak melakukan kegiatan evaluasi pembelajarannya. Hal lain yang diperoleh dari observasi adalah adanya ketimpangan pencapaian hasil penyelesaian soal tes matematika materi bilangan cacah pada kelas yang satu dan kelas yang lain.
Tes soal matematika yang ada di buku pedoman siwa pada umumnya lebih banyak berisikan soal pilihan berganda. Tes pilihan ganda sendiri memiliki sebuah pilihan jawaban yang benar dan pilihan lainnya sebagai pengecoh, dalam hal ini kedudukan pilihan pengecoh sangat vital sebagai pembeda siswa dengan kemampuan tinggi dan siswa dengan kemampuan rendah. Seringkali soal pilihan ganda dibuat dengan tidak menguji kelayakan apakah sudah mencapai standar yang ditetapkan untuk mengukur kemampuan peserta tes atau siswa, padahal jika kualitas butir soal baik dapat digunakan sebagai media penyampaian informasi faktual mengenai kemampuan peserta didik dalam pemahaman materi yang diberikan, begitu sebaliknya jika kualitas soal tes buruk tidak dapat menjadi media untuk penyampaian informasi kemampuan peserta didik. 
Berdasarkan pemaparan latar belakang masalah tersebut diatas, penulis tertarik untuk melaksanakan penelitian yang berjudul “Analisis Soal Tes Belajar Siswa Dalam Pembelajaran Matematika Pada Bilangan Cacah Kelas IV di SD Negeri 104218 Sidomulyo”.
[bookmark: _Toc179454097][bookmark: _Toc189750271]1.2 Identifikasi Masalah
	Berdasarkan latar belakang masalah yang telah dipaparkan, dapat diidentifikasi beberapa hal yang menjadi masalah dalam penelitian ini yakni sebagai berikut:
1. Guru jarang melakukan kegiatan evaluasi terhadap soal-soal yang ada di buku pedoman siswa.
2. Keterbatasan kemampuan guru dalam melakukan kegiatan evaluasi berupa analisis khususnya dalam menentukan validitas, reliabilitas, tingkat kesukaran, daya pembeda, dan efektifitas pengecoh pada soal-soal yang ada pada buku pedoman siswa.
3. Kegiatan evaluasi berupa analisis soal tes belajar khususnya soal matematika materi bilangan cacah jarang dilakukan dan memerlukan waktu yang tidak singkat atau cenderung memakan waktu yang lama serta membutuhkan kemampuan tertentu untuk melakukannya.
[bookmark: _Toc179454098][bookmark: _Toc189750272]1.3 Batasan Masalah
	Guna mencegah penelitian melebar kemana mana, penulis membatasi penelitian ini dengan melakukan evaluasi berupa kegiatan analisis soal tes belajar siswa dalam pembelajaran matematika pada materi bilangan cacah di kelas IV Sekolah Dasar menggunakan beberapa soal yang diambil berdasarkan buku pedoman yang digunakan oleh guru dan siswa.
[bookmark: _Toc179454099][bookmark: _Toc189750273]1.4 Rumusan Masalah
	Berdasarkan paparan latar belakang masalah di atas, maka rumusan masalah penelitian adalah sebagai berikut:
1. Bagaimana validitas soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo ditinjau dari keseluruhan soal?
2. Bagaimana reliabilitas soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo ditinjau dari keseluruhan soal?
3. Bagaimana kualitas tingkat kesukaran soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo ditinjau dari masing-masing item soal?
4. Bagaimana kualitas daya pembeda soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo ditinjau dari masing-masing item soal?
5. Bagaimana efektifitas pengecoh soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo ditinjau dari masing-masing item soal?
[bookmark: _Toc179454100][bookmark: _Toc189750274]1.5 Tujuan Penelitian
	Berdasarkan rumusan masalah diatas, penelitian ini memiliki beberapa tujuan sebagai berikut:
1. Untuk menganalisis validitas soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
2. Untuk menganalisis reliabilitas soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
3. Untuk menganalisis tingkat kesukaran soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
4. Untuk menganalisis daya pembeda soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
5. Untuk menganalisis efektifitas pengecoh soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
[bookmark: _Toc179454101][bookmark: _Toc189750275]1.6 Manfaat Penelitian
[bookmark: _Toc179454102][bookmark: _Toc189750276]1.6.1 Manfaat Teoteris
1. Hasil analisis yang diperoleh dari penelitian ini dapat digunakan sebagai acuan serta masukan di dunia pendidikan dalam melakukan kegiatan evaluasi pembelajaran berupa analisis soal tes belajar.
2. Hasil penelitian ini juga diharapkan sebagai acuan bagi peneliti selanjutnya yang akan melaksanakan penelitian yang ama serta ingin melakukan penelitian yang secara mendalam tentang penelitian ini.
[bookmark: _Toc179454103][bookmark: _Toc189750277]1.6.2 Manfaat Praktis
1. Bagi penulis
a. Menjadi pemanfaatan dari ilmu pengetahuan yang didapat selama duduk perkuliahan serta modal untuk menjadi pendidik yang memiliki kemampuan mumpuni di bidangnya pada masa mendatang.
b. Penelitian ini dijadikan sebagai tugas akhir untuk memperoleh gelar sarjana strata satu (S1).
2. Bagi Guru
a. Dapat digunakan sebagai alat bantu/media untukmelakukan kegiatan evaluasi untuk mengukur kemampuan siswanya memahami materi yang diberikan dan mengetahui tercapainya tujuan pembelajaran.
b. Dapat dijadikan masukan untuk guru-guru pada saat melakukan kegiatan evaluasi berupa analisis soal tes belajar siswa.
c. Dapat mengetahui soal tes yang diberikan kepada siswa apakah sudah valid, reliabel, memiliki tingkat kesukaran dan daya pembeda yang baik atau tidak sehingga dapat diberikan kepada siswa dikemudian hari.
3. Bagi Siswa
a. Sebagai cara untuk mengukur kemampuan dirinya dalam menyelesaikan soal matematika materi bilangan cacah yang diberikan oleh guru.
b. Untuk mengetahui kelebihan dan kekurangan kekurangan dirinya dalam menyelesaikan soal matematika materi bilangan cacah.
4. Bagi Pihak Sekolah
	Dapat digunakan sebagai alat motivasi bagi sekolah agar lebih sering mengadakan bimbingan pelatihan kegiatan evaluasi berupa analisis soal tes belajar yang diberikan ke siswa.
[bookmark: _Toc179454104][bookmark: _Toc189750278]1.7 Anggapan Dasar Penelitian
	Anggapan dasar dalam penelitian biasa diartikan sebagai media untuk membantu pelaksanaan penelitian supaya hasil penelitian lebih jelas dan memiliki fokus yang baik terhadap suatu hal yang ingin diteliti dan sesuai dengan yang diinginkan serta penelitian tidak meluas yang akan mengakibatkan hasil penelitian menjadi tidak maksimal. Dengan kata lain, anggapan dasar penelitian adalah suatu hal yang menjadikan peneliti yakin akan kebenaran anggapan tentang apa yang akan diteliti. Peneliti mampu menganalisis validitas, reliabilitas, tingkat kesukaran, dan daya pembeda soal tes pembelajaran matematika pada materi bilangan cacah di kelas IV SD Negeri 104218 Sidomulyo.
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[bookmark: _Toc179454105][bookmark: _Toc189750279]BAB II
[bookmark: _Toc179454106][bookmark: _Toc189750280]TINJAUAN PUSTAKA
[bookmark: _Toc179454107][bookmark: _Toc189750281]2.1 Kajian Teori
[bookmark: _Toc179454108][bookmark: _Toc189750282]2.1.1 Konsep Evaluasi Pembelajaran
1. Definisi Evaluasi
	Evaluasi merupakan unsur yang penting dalam pembelajaran. Evaluasi yang baik haruslah berdasarkan pada tujuan yang ditetapkan sesuai yang telah direncakan di awal dan selanjutnya diusahakan oleh pendidik dan siswanya (Hidayat & Asyafah, 2019). Selain pendidik, evaluasi juga biasa dilakukan oleh kalangan peneliti dan akademisi seperti yang dipaparkan oleh UUSPN No. 20 Tahun 2003 pasal 58 ayat 1 bahwa evaluasi hasil belajar siswa dilakukan oleh guru dengan tujuan untuk melihat proses, kemajuan belajar, serta perbaikan hasil belajar (Magdalena et al., 2020). Pendapat lain mengatakan bahwa evaluasi adalah sebuah kegiatan utama yang bertujuan mengetahui sampai dimana tingkat capaian kemampuan yang dimiliki peserta didik (Hudri & Umam, 2022). 




	Evaluasi adalah hal penting yang harus dilaksanakan dengan benar selain proses kegiatan belajar mengajar di kelas hal ini dikarenakan proses evaluasi tersebut yang digunakan sebagai alat dalam memperoleh data yang valid tentang kemampuan siswanya (Huljannah, 2021). Mengajar berarti partisipasi dengan pelajar dalam membentuk  sebuah 
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pengetahuan, membuat makna, mencari kejelasan, bersikap kritis, dan mengadakan justifikasi (Yarshal, 2022). Gerald W. Brown dan Edwind Wandt (1977) mengatakan evaluation refer to the act or process to determining the value of something dengan kata lain dapat diartikan sebagai sebuah tindakan atau sebuah proses yang bertujuan mengukur nilai dari sesuatu (Magdalena et al., 2020). Hidayat & Asyafat (2019) mengatakan secara harfiah evaluasi berasala dari bahasa inggris yakni evaluation dan bahasa arab yakni Al-Taqdir yang dalam bahasa indonesia memiliki arti penilaian. Evaluasi tidak hanya dijadikan sebagai penilaian melainkan sebagai sarana pembelajaran bagi para evaluator. Menurut Sudjana (2016) dalam Yusuf (2019) evaluator setidaknya harus memiliki beberapa kemampuan yakni sebagai berikut:
1. Mampu memberikan evaluasi tentang suatu dokumen atau arsip sebuah karya.
2. Mampu memberikan evaluasi berupa asumsi, ketetapan logika serta keterpaduannya.
3. Mampu memberikan pemahaman dan cara pandang orang lain dalam membuat sebuah keputusan.
4. Mampu membandingkan suatu karya dengan karya lain yang sejenis.
5. Mampu melakukan evaluasi berdasarkan kriteria tertentu.
6. Mampu melakukan evaluasi secara gamblang dan tidak berbelit-belit.
	Yang menjadi salah satu ciri utama pada evaluasi adalah mengakhiri kegiatannya dengan memberikan sebuah keputusan secara eksplisit. Arikunto dan Jabar (2012) mengatakan evaluasi adalah sebuah kegiatan untuk mengumpulkan informasi mengenai bekerjanya suatu hal, kemudian informasi yang diperoleh tersebut dipakai untuk menentukan alternatif dalam pengambilan kepuusan (Sutrisno, 2022). Berdasarkan beberapa definisi beberapa ahli dan peneliti diatas, dapat disimpulkan bahwa evaluasi itu sendiri memiliki arti sebuah proses kegiatan pengumpulan informasi faktual tentang sesuatu hal yang akan diamati atau diteliti dan akhirnya informasi tersebut dijadikan sebagai dasar untuk membuat sebuah kesimpulan dan pengambilan keputusan. 
2. Fungsi dan Tujuan Evaluasi Pembelajaran
	Arifin (2017) berpendapat dalam Yusuf (2019) bahwa fungsi dari sebuah evaluasi bisa dikatakan cukup luas tergantung cara pandang yang melihatnya dan cara pandang tersebut dibagi menjadi cara yakni: 1) secara psikologis evaluasi berfungsi sebagai kebutuhan peserta didik dalam melihat sejauh mana kegiatan yang telah dilakukan; 2) secara sosiologis evaluasi berfungsi untuk mengetahui mampu atau tidaknya peserta didik bermasyarakat; 3) secara didaktis metodis evaluasi berfungsi membantu guru mengelompokkan siswa nya berdasarkan kemampuan pemahaman yang dimiliki; 4) evaluasi juga berfungsi mengelompokkan peserta didik sesuai dengan kemampuannya; 5) evaluasi juga berfungsi melihat tingkat kesiapan siswa dalam menempuh pendidikan; 6) evaluasi berfungsi membantu guru menentukan siswa yang layak naik kelas dan menentukan jenis pendidikan selanjutnya; dan 7) secara administratif evaluasi berfungsi sebagai laporan pendidik kepada orang tua peserta didik mengenai hasil belajar anaknya. Selain itu, Oemar Hamalik (2002) mengungkapkan bahwa fungsi dari evaluasi terdiri dari 6 hal yakni fungsi edukatif, fungsi institusional, fungsi diagnostik, fungsi administratif, fungsi kurikuler (Sutrisno, 2022).  Pendapat lain menurut Sudijono dikatakan bahwa secara umum, evaluasi sebagai suatu tindakan proses memiliki tiga macam fungsi utama, yakni: 1)  mengukur kemajuan; 2) menunjang penyusunan rencana; 3) memperbaiki atau melakukan penyempurnaan kembali (Hidayat & Asyafah, 2019).
	Dari beberapa pendapat diatas dapat diketahui bahwa evaluasi memiliki banyak fungsi tergatung hal tujuan yang ingin dicapai oleh evaluator, namun tetap saja kegiatan evaluasi berfungsi sebagai sarana untuk memperoleh tujuan yang ingin dicapai.
	Selain fungsi, evaluasi juga memiliki tujuan tertentu dan cukup beragam. Sudjana (2016) memaparkan bahwa tujuan evaluasi terdiri dari beberapa hal yakni sebagai berikut:
a. Mendeskripsikan kemampuan kelebihan dan kekurangan peserta didik dalam proses pembelajaran;
b. Mengetahui berhasil atau tidaknya proses pembelajaran disekolah
c. Membuat tindak lanjut proses pembelajaran;
d. Memberikan pertanggungjawaban pendidik kepada satuan pendidikan tempatnya mengajar.
	Tujuan evaluasi dalam pembelajaran merupakan sarana untuk mengetahui keefektifan dan efisiensi sistem pembelajaran yang diberikan, baik mengenai tujuan, materi, metode, media, sumber belajar, lingkungan ataupun sistem penilaian (Arifin, 2012; Hidayat & Asyafah, 2019). Dalam buku terdahulunya, Anas Sudijono mengatakan tujuan evaluasi memiliki dua tujuan utama tujuan umum dan tujuan khusus yang masing-masing bertujuan mengumpulkan bahan, barang serta keterangan yang dipakai sebagai bukti perkembangan kemajuan peserta didik; dan untuk merangsang kegiatan peserta didik dalam menempuh program pendidikan.
3. Teknik Evaluasi Pembelajaran
	Pada dasarnya, teknik merupakan bentuk cara dalam menyampaikan sesuatu menggunakan kemampuan tertentu. Dengan kata lain, teknik evaluasi pembelajaran dapat dimaknai sebagai sarana yang dipakai kegiatan evaluasi. Sebagaimana diketahui tugas utama seorang guru adalah mendidik siswa dan menjadi sumber belajar siswa, namun tak hanya itu guru juga dituntut harus mampu menguasai teknik dalam melakukan kegiatan evaluasi dengan baik dan benar sehingga memperoleh penilaian yang tepat (Balau et al., 2021). Pada umumnya teknik evaluasi pembelajaran digolongkan menjadi 2 macam, yakni teknik tes dan non tes (Hidayat & Asyafah, 2019). Teknik tes merupakan prosedur yang dipakai pada saat mengukur dan menilai, yang berisikan pertanyaan, perintah dan petunjuk yang memiliki tujuan mengukur tingkat kemampuan seseorang (Aminoro & Daryanto, 2016; Huljannah, 2021). Sedangkan menurut Amir Daien dan Anas Sudijono tes merupakan alat yang disusun secara sistematis dan bersifat objektif yang digunakan untuk memperoleh data dan keterangan yang diinginkan tentang seseorang. Arifin mengungkapkan bahwa untuk mengukur prestasi belajar bidang kognitif, analisis, aplikasi dan pemahaman instrumen yang digunakan berupa instrumen tes (Arifin, 2017; Yusuf, 2019). Dari segi kegunaan untuk mengukur siswa, teknis tes terdiri dari tes diagnostik, tes formatif, dan tes sumatif (Asrul et al, 2022). Menurut pendapat lain, teknik tes adalah cara mengumpulkan informasi untuk melihat hasil belajar siswa dengan menggunakan instrumen  tes (Huljannah, 2021). Dengan demikian teknik tes adalah teknik evaluasi pembelajaran yang digunakan sebagai alat pengukur kemampuan siswa menggunakan pertanyaan-pertanyaan yang disusun secara sistematis dan dipakai untuk memperoleh informasi.
	Sedangkan teknik non tes adalah teknik evaluasi pembelajaran yang dilaksanakan tanpa melakukan uji pada peserta didik, akan tetapi dilakukan menggunakan cara tertentu, yakni dengan cara observation, interview, documentary analysis (Asrul et al, 2022). Teknik non tes dimaknai dengan cara mengumpulkan peningkatan belajar dengan tidak memakai tes (Bisri, 2015; Huljannah, 2021). Pada umumnya teknik non tes digunakan untuk memberi penilaian kepada tingkah laku, keteramilan, dan kemampuan bersosial peserta didik. Daryanto (2012) mengatakan teknik non tes terdiri dari beberapa hal yakni skala bertingkat, kuisioner, daftar cocok, wawancara, pengamatan, dan riwayat hidup (Hidayat & Asyafah, 2019). Instumen non tes berupa kuesioner atau angket yang berisi pertanyaan yang sesuai keadaan (Huljannah, 2021). Dengan demikian, teknik non tes adalah teknik yang digunakan dalam mengevaluasi pembelajaran tidak dengan menggunakan pertanyaan yang harus diselesaikan namun pertanyaan yang harus diisi berdasarkan keadaan yang sebenarnya serta menggunakan pengamatan tertentu terhadap personality seseorang.
[bookmark: _Toc179454109][bookmark: _Toc189750283]2.1.2 Analisis Soal Tes Belajar
	Analisis adalah upaya memilah suatu integritas menjadi unsur-unsur atau elemen jelas urutan dan susunannya (Sudjana, 2016; Yusuf, 2019). Selanjutnya, analisis soal adalah aktivitas menkaji pertanyaan yang akan dipakai untuk tes guna mendapatkan instrumen pertanyaan atau soal yang memiliki kualitas yang mumpuni (Rahmayani et al., 2022). Tujuan dari menganalisis soal yaitu dengan memeriksa dan menelaah untuk mendapatkan yang berkualitas, sehingga dapat meningkatkan kualitas pengujian dengan merevisi serta menghilangkan soal yang baik (Balau et al., 2021). Analisis kualitas tes adalah suatu tahap yang wajib ditempuh untuk mengetahui derajat kualitas keseluruhan tes ataupun butir soal yang ada pada tes tersebut (Arifin, 2017; Yusuf, 2019). Analisis terhadap butir soal bentuk objektif berhubungan dengan taraf kesukaran soal, daya pembeda soal, analisis validitas, analisis reliabilitas serta fungsi distraktor (Firmansyah, 2018; Tilaar et al., 2020). Sementara itu, soal tes yang baik wajib memiliki karakter penilaian butir soal yang berisi validitas, reliabilitas, tingkat kesukaran, daya pembeda, dan pengecoh (Pasi & Yusrizal, 2018; Yusuf, 2019). Analisis soal tes belajar merupakan proses memeriksa dan menilai tes untuk memastikan kualitas dan memahami karakteristik tes yang dipakai. Tujuannya adalah untuk memastikan bahwa soal tes dapat mengukur yang harus diukur dan memperoleh informasi yang berguna tentang kemampuan atau pengetahuan yang diuji. Berikut ini adalah beberapa aspek penting yang perlu dipertimbangkan dalam analisis soal tes belajar:
1. Validitas mendasari pada sejauh mana sebuah tes dapat mengukur apa yang akan diukur. Dalam analisis soal tes, penting untuk memastikan bahwa butir tes cocok dengan tujuan pengukuran dan mewakili apa yang diinginkan.
2. Reliabilitas mendasari pada konsistensi atau kestabilan hasil tes. Dalam analisis soal, perlu dipastikan bahwa butir tes memberikan hasil yang konsisten jika diujikan kepada sampel yang sama atau serupa pada waktu yang berbeda.
3. Kesulitan butir tes harus sesuai dengan tingkat kemampuan peserta tes. Butir yang terlalu mudah atau terlalu sulit dapat mengurangi validitas tes.
4. Kekeliruan atau distraktor merupakan pilihan jawaban yang salah dalam sebuah butir tes pilihan ganda. Dalam analisis soal, penting untuk memastikan bahwa kekeliruan yang dipilih membedakan antara peserta tes yang memiliki pengetahuan yang tepat atau tidak.
5. Kejelasan adalah butir tes harus dirumuskan dengan jelas dan mudah dipahami oleh peserta tes. Bahasa yang digunakan harus sesuai dengan kemampuan dan latar belakang peserta tes.
6. Gagasan utama adalah butir tes harus mencerminkan gagasan utama atau inti dari materi yang diuji. Analisis soal harus memastikan bahwa setiap butir tes relevan dengan materi pelajaran yang diajarkan.
7. Format butir-butir tes harus sesuai dengan jenis tes yang digunakan (misalnya, pilihan ganda, esai, benar/salah, dll.) dan tujuan pengukuran.
8. Keterwakilan adalah butir tes harus mencakup berbagai aspek materi pelajaran yang diuji dan mencerminkan keragaman peserta tes.
Dengan memperhatikan aspek-aspek ini dalam analisis soal tes belajar, Anda dapat meningkatkan kualitas tes dan memastikan bahwa tes memberikan informasi yang berguna tentang kemampuan atau pengetahuan peserta tes.
1. Validitas
		Sugiyono (2017) validitas bisa menunjukkan derajat keakuratan data sebenarnya dengan data yang dikumpulkan oleh seorang peneliti (Rahmayani et al., 2022). Validitas juga bisa berkaitan dengan keakuratan media penilaian yang dipergunakan untuk menilai apa yang akan dinilai (Tilaar et al., 2020). Tes dikatakan mempunyai nilai validitas yang tinggi jika mampu berfungsi dengan baik untuk mengukur sesuatu yang akan di ukur. Validitas berisi dua unsur dimana unsur pertama memuat derajat sempurna, sedang, dan rendah sedangkan unsur kedua validitas selalu dihubungkan dengan keputusan yang spesifik (Arifin, 2017; Yusuf, 2019). 
		Teknik yang digunakan untuk menguji validitas empiris ini dilakukan dengan menggunakan rumus korelasi product moment (Arikunto, 2013).

Keterangan:
	= Koefisien korelasi antara variabel X dan variabel Y
N	= Jumlah Siswa
	= Jumlah skor siswa pada setiap butir soal
      = Jumlah total skor siswa
  = Jumlah hasil perkalian skor siswa pada setiap butir soal  
dengan total skor siswa.
1. 
2. Reliabilitas
		Mehrens, et al dalam Retnawati (2012) reliabilitas adalah tingkat konsistensi hasil pengukuran pada suatu objek yang lebih dari sekali dilakukan walaupun dengan alat ukur yang berbeda dan menggunakan skala yang berbeda (Rahmayani et al., 2022). Sudjana (2016) dalam Yusuf (2019) mengungkapkan sebuah tes bisa dikategorikan reliabel jika tes di ujicoba lebih dari sekali menunjukkan hasil yang relative sama. Arifin (2017) mengatakan reliabilitas merupakan tingkat atau derajat konsistensi nya suatu instrumen yang digunakan. Dengan demikian, sebuah soal tes dikatakan reliabel jika soal yang diberikan lebih dari sekali kepada siswa masih mendapatkan hasil yang tidak jauh berbeda dari tes tes sebelumnya.
Arikunto (2013:122)  untuk menghitung reliabilitas dapat digunakan rumus  Alpha, yaitu:
= 
Keterangan :
= realibilitas yang dicari
 = jumlah Varians skor tiap-tiap item
    = varians total
Anas Sudijono (2015) berpendapat bahwa suatu tes dikatakan baik apabila memiliki nilai reliabilitas ≥ 0,70.
3. Tingkat Kesukaran
		Tingkat kesukaran menurut pandangan Widyastuti dan Mardiah (2016) tingkat kesukaran dikatakan baik jika peserta didik yang mampu menjawab benar dan salah dari  soal sukar dan sedang lebih banyak ketimbang yang menjawab soal mudah (Fauziana & Dessy Wulansari, 2021). Sudjana (2016) dalam Yusuf (2019) tingkat kesukaran soal dilihat dari kesanggupan siswa dalam menjawabnya dengan kata lain soal yang tidak dijawab oleh kebanyakan siswa tidak dapat diukur tingkat kesukarannya. Indeks tingkat kesukaran soal dapat dihitung manual menggunakan rumus berikut (Sudjana, 2016; Yusuf, 2019):

Ket : 
 = indeks kesukaran tiap soal
 = banyak siswa menjawab benar
 = banyak siswa yang memberi jawaban pada soal tersebut
		Hasil yang diperoleh dari rumus tersebut disesuaikan dengan kriteria sebagai berikut:
	= kategori mudah;
 	= kategori sedang;
 	= kategori sukar.
		Selain secara manual, tingkat kesukaran soal dapat dihitung menggunakan bantuan aplikasi SPSS.
4. Daya Pembeda
		Pengukuran sampai dimana soal mampu memberi perbedaan siswa yang sudah menguasai kompetensi yang diajarkan dan yang belum menguasai kompetensi yang diajarkan (Arifin, 2017; Yusuf, 2019). Indeks daya pembeda dapat dihitung manual dengan menggunakan rumus sebagai berikut (Arifin, 2017; Yusuf, 2019):

Ket: 
D	= daya pembeda
WL	= jumlah siswa gagal dari kelompok bawah
WH	= jumlah siswa gagal dari kelompok atas
n 	= 27%  N
		Hasil yang diperoleh dari rumus tersebut disesuaikan dengan kriteria sebagai berikut: 
 daya pembeda jelek
 daya pembeda cukup
 daya pembeda baik
 daya pembeda baik sekali
 negatif daya pembeda sangat jelek
		Selain menggunakan rumus tersebut, efektifitas pengecoh juga dapat dihitung secara otomatis menggunakan aplikasi SPSS.
5. Efektifitas Pengecoh
		Direktorat Pembinaan SMA mengungkapkan bahwa opsi jawaban (pengecoh) dikatakan efektif apabila dipilih minimal sekitar 5% dari siswa yang menjawab (Yusuf, 2019). Senada dengan hal tersebut, Pengecoh dikatakan baik apabila siswa yang memilih pengecoh tersebut mendekati atau sama dengan jumlah idealnya (Yusuf, 2019). Untuk menghitung efektifitas pengecoh dapat digunakan rumus sebagai berikut (Arifin, 2017; Yusuf, 2019):

Ket:
 	= Indeks Pengecoh
 	= total siswa yang memilih pengecoh
 	= total siswa yang ikut tes
 	= total siswa yang menjawab benar
 	= jumlah opsi
 	= bilangan tetap
		Selain menggunakan rumus tersebut, efektifitas pengecoh juga dapat dihitung secara otomatis menggunakan aplikasi SPSS.
[bookmark: _Toc179454110][bookmark: _Toc189750284]2.1.3 Bilangan Cacah
	Bilangan cacah adalah bilangan bulat positif yang dimulai dari angka 0 sebagai permulaan atau {0,1,2,3,…} (Puspitaningrum, 2020).  Di Sekolah Dasar (SD), bilangan cacah mengacu pada bilangan bulat tidak negatif yang dipakai menghitung jumlah benda, orang, atau suatu kejadian. Dalam konteks pembelajaran matematika di SD, bilangan cacah adalah bilangan yang bisa dihitung secara langsung dan tidak memiliki bagian pecahan atau desimal. Selain itu, bilangan cacah adalah bilangan bulat positif yang dimulai dari angka 0. Jadi, contoh bilangan cacah adalah 0, 1, 2, 3, 4, dan seterusnya. Jadi, misal ada soal untuk menyebutkan bilangan cacah kurang dari 10, jawabannya adalah 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 (Academy, 2022)
[bookmark: _Toc189750285][bookmark: _Toc179454111]2.2 Aplikasi SPSS
	Statistical Package for the Social Sciences atau dikenal dengan sebutan SPSS pertama kali dikembangkan oleh Norman H. Nie, C. Hadlai "Tex" Hull, dan Dale H. Bent pada tahun 1968 dengan tujuan dijadikan sebagai alat bantu para peneliti bidang ilmu sosial yang tidak memiliki kemampuan analisis statistik yang cukup rumit (Kusnadi, 2008). Pada tahun 1975  SPSS, SPSS mulai tersedia dalam versi pertama (SPSS 1.0) yang dapat dijalankan di mainframe IBM dan pada tahun 2009, SPSS Inc. diakuisisi oleh IBM seharga sekitar $1,2 miliar. Setelah akuisisi ini, SPSS mulai dikenal sebagai IBM SPSS Statistics dan terus berkembang dengan tambahan alat dan kemampuan baru untuk analisis data, pemodelan prediktif, dan analisis data besar. Hingga saat ini SPSS telah berevolusi sejak awalnya sebagai software yang dirancang untuk penelitian sosial menjadi alat analisis statistik yang sangat kuat dan serbaguna. Dengan akuisisi oleh IBM, SPSS semakin diperkuat dengan teknologi baru, dan kini digunakan secara luas oleh akademisi, profesional bisnis, dan peneliti di berbagai bidang.
Berikut adalah langkah-langkah prosedural untuk menggunakan SPSS dalam melakukan analisis data. Proses ini mencakup mulai dari memasukkan data hingga melakukan analisis statistik:
1. Membuka dan Menyiapkan SPSS:
· Buka aplikasi SPSS di komputer.
· Setelah membuka SPSS, Anda akan melihat dua tampilan utama:
· Data View: Tempat untuk memasukkan data dalam bentuk tabel.
· Variable View: Tempat untuk mendefinisikan atribut setiap kolom (variabel), seperti nama variabel, tipe data, label, dan lainnya.
2. Memasukkan Data ke dalam SPSS:
· Pada Data View, masukkan data yang akan dianalisis. Setiap kolom mewakili satu variabel, dan setiap baris mewakili satu observasi (contoh: responden atau sampel).
· Jika Anda sudah memiliki data dalam file lain (misalnya Excel), Anda dapat mengimpor data:
· Pilih File > Open > Data dan pilih file yang ingin diimpor.
· Pilih format file yang sesuai (misalnya Excel, CSV).
3. Mendefinisikan Variabel (Variable View):
· Pergi ke Variable View untuk mendefinisikan variabel-variabel Anda.
· Di sini Anda dapat mengatur atribut berikut:
· Nama: Nama variabel (misalnya, umur, jenis kelamin).
· Tipe: Jenis data (nominal, ordinal, skala).
· Label: Deskripsi lengkap dari variabel.
· Nilai: Jika variabel kategori, definisikan nilai numerik yang digunakan untuk representasi kategori (misalnya, 1 = Laki-laki, 2 = Perempuan).
· Missing: Menentukan nilai yang hilang (misalnya, jika ada data yang tidak lengkap).
4. Melakukan Analisis Statistik:
SPSS menyediakan berbagai macam analisis statistik yang dapat dilakukan. Berikut adalah beberapa prosedur umum:
a. Analisis Deskriptif (Descriptive Statistics):
· Pilih Analyze > Descriptive Statistics > Frequencies (untuk data kategori) atau Analyze > Descriptive Statistics > Descriptives (untuk data numerik).
· Pilih variabel yang ingin dianalisis dan klik OK untuk melihat hasilnya.
b. Uji T (Independent T-Test):
· Pilih Analyze > Compare Means > Independent-Samples T Test.
· Pilih variabel yang ingin diuji dan kelompokkan berdasarkan variabel independen (misalnya, jenis kelamin atau kelompok eksperimen).
· Klik OK untuk melihat hasil uji t.
c. ANOVA (Analysis of Variance):
· Pilih Analyze > Compare Means > One-Way ANOVA.
· Pilih variabel dependen dan faktor (variabel kategori) yang ingin diuji.
· Klik OK untuk mendapatkan hasil analisis varians.
d. Regresi (Regression Analysis):
· Pilih Analyze > Regression > Linear untuk analisis regresi linier.
· Pilih variabel dependen dan independen, kemudian klik OK untuk melihat hasil regresi.
e. Uji Korelasi:
· Pilih Analyze > Correlate > Bivariate untuk menguji korelasi antara dua atau lebih variabel.
· Pilih variabel yang ingin diuji dan klik OK.
5. Menampilkan Grafik dan Visualisasi Data:
· Untuk membuat grafik, pilih Graphs > Legacy Dialogs atau Graphs > Chart Builder.
· Pilih jenis grafik yang diinginkan (misalnya, histogram, boxplot, pie chart).
· Tentukan variabel yang akan diplot dan sesuaikan pengaturannya, lalu klik OK.
6. Menginterpretasi Hasil:
· Setelah analisis selesai, SPSS akan menghasilkan output yang berisi tabel dan grafik.
· Output ini akan muncul di jendela Output Viewer. Anda dapat melihat hasil analisis dalam bentuk tabel dan interpretasi statistik (misalnya, p-value, koefisien regresi, atau nilai F dalam ANOVA).
· Untuk analisis deskriptif, SPSS akan menampilkan statistik seperti rata-rata, standar deviasi, dan frekuensi.
7. Menyimpan Hasil:
· Hasil analisis (baik data maupun output) dapat disimpan ke dalam file. Pilih File > Save As untuk menyimpan data dan output.
· Untuk menyimpan data yang telah dianalisis dalam format SPSS (.sav) atau format lain (misalnya Excel), pilih File > Save As dan pilih format yang diinginkan.
8. Mencetak atau Mengekspor Hasil:
· Anda dapat mencetak hasil analisis atau mengekspornya ke dalam format lain, seperti PDF atau Word, dengan memilih File > Export atau File > Print.
	Aplikasi SPSS merupakan aplikasi yang umum digunakan banyak kalangan peneliti karena dikenal dengan kemudahan menggunakan serta keberagaman serta kecanggihan fitur yang diperlukan dalam mengolah data penelitian.
[bookmark: _Toc189750286]2.3 Penelitian Terdahulu
	Dalam sebuah karya ilmiah, diperlukan penelitian terdahulu guna mendukung opini dan hasil penelitian yang diperoleh. Dalam penelitian ini ada beberapa penelitian terdahulu yang digunakan sebagai dasar dan petunjuk pelaksanaan penelitian dalam tabel sebagai berikut:

[bookmark: _Toc179452149][bookmark: _Toc182496752][bookmark: _Toc182660673]Tabel 2.1 Penelitian Terdahulu
	No
	Judul Artikel (Penulis)
	Perbedaan
	Persamaan

	1
	Analisis Kualitas Butir Soal Ujian Nasional Mata Pelajaran Matemtika SMP/MTs Tahun Pelajaran 2017/2018 (Riduan Yusuf)
	Instrumen soal yang digunakan
	Analisis validitias, reliabilitas, daya pembeda, dan tingkat kesukaran

	2
	Analisis Kualitas Butir Soal Tes Buatan Guru Mata Pelajaran Matematika Kelas X SMA Negeri 1 Airmadidi Tahun Ajaran 2019/2020 (Tilaar dkk)
	Instrumen soal yang digunakan dan jenjang pendidikan pada sampel
	Analisis validitias, reliabilitas, daya pembeda, tingkat kesukaran,

	3
	Analisis Kualitas Butir Soal Buatan Guru Mata Pelajaran Matematika Kelas VIII SMP Negeri Satap Matabulu Kabupaten Bolaang Mongondow Timur (Balau dkk)
	Teknik pengumpulan data hanya wawancara dan dokumentasi
	Analisis validitias, reliabilitas, daya pembeda, tingkat kesukaran

	4
	Analisis kualitas Butir Soal Ulangan Harian di Sekolah Dasar dengan Model Rasch (Fauziana & Wulansari)
	Model penelitian menggunakan model Rasch
	Analisis validitias, reliabilitas, dan tingkat kesukaran



[bookmark: _Toc179454112][bookmark: _Toc189750287]2.4 Kerangka Berpikir
	Dalam rangka melakukan evaluasi hasil belajar siswa guna melihat validitas, reliabilitas, tingkat kesukaran, daya pembeda, serta efektifitas pengecoh maka kegiatan alaisis perlu dilakukan. Hal ini perlu dilakukan dengan tujuan untuk memperoleh informasi tentang validitas, reliabilitas, tingkat kesukaran, daya pembeda, serta efektifitas pengecoh serta tindak lanjut tentang pembelajaran yang telah dilakukan. Kegiatan analisis ini memerlukan tahapan-tahapan tertentu berdasarkan pedoman dan kriteria yang telah diungkapkan oleh peneliti-peneliti terdahulu. Untuk lebih jelasnya, akan ditampilkan dalam bentuk bagan sebagai berikut:
Melakukan validasi kunci jawaban
Perlu dilakukan analisis
Guru belum melakukan kegiatan analisis mengenai soal bilangan cacah yang diujikan 




Mengumpulkan soal bilangan cacah yang pernah diujikan guru

Membuat kunci jawaban



Dosen
Guru


Melakukan Ujicoba Soal

Lembar Jawaban Siswa

Analisis Soal Tes


Efektifitas Pengecoh
Daya Pembeda
Tingkat Kesukaran
Reliabilitas
Validitas


Membuat Kesimpulan


[bookmark: _Toc179454113][bookmark: _Toc189750288]2.5 Hipotesis
	Hipotesis adalah perpaduan dari kata “hipo” dan “tesis” yang masing-masing memiliki arti dibawah dan kebenaran (Setyawan, 2014). Pendapat lain mengatakan hipotesis adalah hasil jawaban sementara atas pertanyaan penelitian, yang diharapkan dapat memandu jalan penelitian (Taufik & Yam, 2021). 
Hipotesis pada penelitian ini adalah sebagai berikut:
 soal tes yang digunakan tidak bersifat valid, tidak reliabel, memiliki tingkat kesukaran mudah, daya pembeda sangat jelek, dan efektifitas pengecoh kurang baik.
 soal tes yang digunakan bersifat valid, reliabel, memiliki tingkat kesukaran sukar, daya pembeda baik sekali, dan efektifitas pengecoh baik. 
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[bookmark: _Toc179454114][bookmark: _Toc189750289]BAB III
[bookmark: _Toc179454115][bookmark: _Toc189750290]METODE PENELITIAN
[bookmark: _Toc179454116][bookmark: _Toc189750291]3.1 Desain Penelitian
	Penelitian ini merupakan jenis penelitian kuantitatif dengan menggunakan metode deskriptif. Dengan kata lain, hasil penelitian yang diperoleh akan dideskripsikan sedemikian rupa sehingga memudahkan untuk para pembaca. Penelitian jenis ini bermaksud untuk mengetahui informasi yang ada pada data berupa tes soal (Arifin, 2017). Oleh karena itu penelitian ini adalah penelitian yang bermaksud memperoleh informasi validitas, reliabilitas, tingkat kesukaran, daya pembeda dan efektifitas pengecoh sesuai kriteria yang telah ditentukan dalam bentuk persentase. Untuk lebih jelasnya, penelitian ini dilakukan melalui beberapa tahapan sebagai berikut:
1. Membuat serta mengumpulkan soal bilangan cacah yang akan di ujikan.
2. Membuat kunci jawaban soal yang diujikan.
3. Melakukan validasi soal dan kunci jawaban ke validator.
4. Melakukan ujicoba tes yang telah divalidasi.
5. Menganalisis validitas, reliabilitas, tingkat kesukaran, daya pembeda, dan efektifitas pengecoh.
· Validitas
	Validitas dapat diartikan jika sebuah tes yang dilakukan dapat menunjukkan derajat ketepatan data yang ada dan dapat mengukur apa yang akan diukur.




· Reliabilitas
33

	Reliabilitas adalah tingkat konsistensi sebuah tes yang dilakukan berulang-ulang sehingga mendapatkan hasil tes yang relatif sama.
· Tingkat Kesukaran
	Derajat kesukaran butir soal yang dapat membedakan kemampuan siswa dalam menjawabnya disebut tingkat kesukaran butir soal, semakin tinggi persentase siswa yang mampu menjawab soal maka semakin rendah tingkat kesukarannya dan sebaliknya jika semakin rendah persentase siswa yang mampu menjawabnya maka semakin tinggi tingkat kesukaran butir soal tersebut.
· Daya pembeda
	Daya pembeda dapat diartikan sebagai alat ukur sampai dimana butir soal mampu membedakan kemampuan kompetensi yang dimiliki siswa dalam memahami soal yang ada.
· Efektifitas Pengecoh
	Tingkat keberfungsian pilihan yang ada pada butir soal yang mampu menjadi pemikat bagi peserta didik yang kurang memahami soal konsep dan materi yang diberikan.
6. Membuat kesimpulan.
[bookmark: _Toc179454117][bookmark: _Toc189750292]3.2 Subjek dan Objek Penelitian
	Subjek penelitian ini adalah siswa kelas IV SDN 104218 Sidomulyo dan objek penelitian ini adalah hasil lembar jawaban tes soal matematika materi bilangan cacah yang telah diberikan yang kemudian di analisis untuk melihat validitas, reliabilitas, tingkat kesukaran, daya pembeda dan efektifitas pengecohnya.
[bookmark: _Toc179454118][bookmark: _Toc189750293]3.3 Populasi dan Sampel
	Populasi pada penelitian ini adalah seluruh siswa kelas IV SDN 104218 Sidomulyo yang berjumlah 42 siswa dari dua kelas, sedangkan sampel pada penelitian ini adalah 23 orang yang ada di salah satu kelas hal ini diperoleh berdasarkan rekomendasi dari guru kelas yang mengajar di kelas tersebut.
[bookmark: _Toc179454119][bookmark: _Toc189750294]3.4 Instrumen Penelitian
	Yang akan digunakan sebagai instrumen dalam penelitian ini adalah:
1. Lembar observasi wawancara terhadap guru mata pelajaran matematika.
2. Kisi-kisi instrumen soal dengan materi Bilangan Cacah pada Kurikulum Merdeka yang berisikan 5 sub materi.
3. Soal tes berupa 15 butir soal pilihan berganda matematika materi bilangan cacah untuk kelas IV Sekolah Dasar. Soal tersebut diambil dari buku panduan yang dipakai guru untuk mengajar dimana beberapa diantaranya soal dipakai untuk tes ulangan harian siswa.
4. Kunci jawaban, yang dibuat sendiri oleh peneliti kemudian dilakukan validasi kedua orang validator yakni validator dosen serta validator guru kelas IV SD. 
5. Instrumen selanjutnya yang digunakan pada penelitian ini adalah hasil lembar jawaban soal tes belajar matematika siswa materi bilangan cacah masing-masing siswa. Hasil dari lembar jawaban inilah yang kemudian di analisis untuk mengetahui validitas, reliabilitas, tingkat kesukaran, daya pembeda dan efektifitas pengecohnya.
6. Instrumen untuk mengolah data menggunakan bantuan Software SPSS.
[bookmark: _Toc179454120][bookmark: _Toc189750295]3.5 Prosedur Penelitian
	Prosedur penelitian merupakan komponen penting yang harus dimiliki oleh sebuah penelitian. Prosedur penelitian sendiri berguna untuk menciptakan sebuah penelitian yang terstruktur dan memiliki tingkat keabsahan yang cukup baik. Jika suatu penelitian memiliki prosedur yang jelas maka tujuan yang akan dicapai oleh peneliti akan lebih efisien dan efektif. 
	Penelitian yang akan dilakukan ini direncanakan memiliki dua tahapan yakni sebagai berikut: 
1. Tahap Persiapan
a. Meminta izin ke sekolah SDN 104218 Sidomulyo untuk melakukan observasi dan penelitian.
b. Melakukan diskusi dan wawancara guru mengenai soal tes pembelajaran matematika materi bilangan cacah yang akan digunakan.
c. Membuat kunci jawaban 15 butir soal bilangan cacah yang telah ditentukan sebelumnya.
d. Melakukan validasi kunci jawaban yang telah dibuat kepada dua orang validator yakni dosen dan guru sekolah dasar.
e. Soal dan kunci jawaban sudah divalidasi.
1. 
2. Tahap Pelaksanaan Penelitian
a. Mengujikan soal tes yang telah ditentukan kepada 23 orang siswa kelas IV A SDN 104218 Sidomulyo.
b. Mengumpulkan hasil jawaban siswa.
c. Melakukan analisis terhadap hasil jawaban siswa.
d. Menentukan validitas, reliabilitas, tingkat kesukaran, daya pembeda dan efektifitas pengecoh dari hasil jawaban siswa yang diperoleh.
e. Membuat kesimpulan.
[bookmark: _Toc179454121][bookmark: _Toc189750296]3.6 Analisis Data
	Teknik analisis yang digunakan pada penelitian ini adalah teknik analisis kuantitatif tipe deskriptif. Teknik ini merupakan pengolahan data yang terkumpul secara deskriptif kuantitatif digunakan untuk memberikan gambaran terhadap keadaan yang sebenarnya, juga untuk menjawab pertanyaan yang berhubungan dengan status subjek dari penelitian (Isnawati et al., 2020). Pendapat lain mengatakan penelitian deskriptif kuantitatif adalah mendeskripsikan, meneliti, dan menjelaskan sesuatu yang dipelajari apa adanya, dan menarik kesimpulan dari fenomena yang dapat diamati dengan menggunakan angka-angka (Sulistyawati et al., 2022). Sehingga pada penelitian ini hasil lembar jawaban siswa di analisis dengan menghitung skor yang diperoleh dan membandingkannya dengan kriteria yang telah ditentukan sebelumnya dan kemudian mendeskripsikan dan menyajikannya dengan semenarik mungkin agar memudahkan orang lain untuk membaca dan memahaminya. Perhitungan skor siswa siswa dilakukan dengan berbantuan aplikasi SPSS. 


37



[bookmark: _Toc189750297]BAB IV
[bookmark: _Toc189750298]HASIL DAN PEMBAHASAN

[bookmark: _Toc189750299]4.1 Hasil Penelitian
Instrumen yang digunakan dalam penelitian ini yakni berupa 15 butir soal soal pilihan berganda diolah menggunakan bantuan aplikasi Software SPSS untuk menentukan validitas, reliabilitas, tingkat kesukaran, daya pembeda, dan efektifitas pengecoh soal. Berdasarkan hasil uji instrumen 15 butir soal yang diujikan kepada 23 sampel atau responden siswa diperoleh hasil pada Lampiran 5.
[bookmark: _Toc189750300]4.1.1 Validitas
	Berdasarkan data yang diperoleh pada Lampiran 5, kemudian dilakukan pengolahan data menggunakan bantuan aplikasi SPSS untuk menentukan validitas tiap butir soal maka diperoleh hasil sebagai berikut:
[bookmark: _Toc182496650][bookmark: _Toc182496760][bookmark: _Toc189750596]Tabel 4.1 Nilai Validitas Hasil Olahan SPSS
	Correlations

	
	Soal_1
	Soal_2
	Soal_3
	Soal_4
	Soal_5
	Soal_6
	Soal_7
	Soal_8
	Soal_9
	Soal_10
	Soal_11
	Soal_12
	Soal_13
	Soal_14
	Soal_15
	Jumlah

	Soal_1
	Pearson Correlation
	1
	-0,045
	-0,137
	-0,394
	0,215
	-0,151
	0,215
	0,477*
	-0,054
	-0,054
	0,215
	0,123
	-0,255
	-0,233
	0,215
	0,237

	
	Sig. (2-tailed)
	
	0,837
	0,532
	0,063
	0,326
	0,492
	0,326
	0,021
	0,806
	0,806
	0,326
	0,575
	0,240
	0,285
	0,326
	0,277

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_2
	Pearson Correlation
	-0,045
	1
	0,214
	-0,045
	0,032
	0,215
	0,215
	-0,045
	-0,054
	-0,054
	0,215
	0,313
	-0,066
	0,302
	0,215
	0,495*

	
	Sig. (2-tailed)
	0,837
	
	0,327
	0,837
	0,886
	0,326
	0,326
	0,837
	0,806
	0,806
	0,326
	0,147
	0,765
	0,161
	0,326
	0,016

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_3
	Pearson Correlation
	-0,137
	0,214
	1
	0,389
	-0,088
	-0,272
	0,280
	-0,137
	0,016
	0,195
	0,280
	-0,008
	-0,008
	0,195
	-0,272
	0,345

	
	Sig. (2-tailed)
	0,532
	0,327
	
	0,066
	0,689
	0,209
	0,195
	0,532
	0,944
	0,372
	0,195
	0,970
	0,970
	0,372
	0,209
	0,107

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_4
	Pearson Correlation
	-0,394
	-0,045
	0,389
	1
	0,032
	-0,151
	0,032
	-0,220
	-0,054
	0,124
	0,032
	-0,066
	0,123
	0,481*
	0,032
	0,274

	
	Sig. (2-tailed)
	0,063
	0,837
	0,066
	
	0,886
	0,492
	0,886
	0,314
	0,806
	0,573
	0,886
	0,765
	0,575
	0,020
	0,886
	0,206

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_5
	Pearson Correlation
	0,215
	0,032
	-0,088
	0,032
	1
	0,042
	0,233
	0,032
	-0,398
	-0,024
	0,042
	0,112
	0,112
	-0,024
	0,042
	0,272

	
	Sig. (2-tailed)
	0,326
	0,886
	0,689
	0,886
	
	0,850
	0,284
	0,886
	0,060
	0,912
	0,850
	0,610
	0,610
	0,912
	0,850
	0,209

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
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	Soal_6
	Pearson Correlation
	-0,151
	0,215
	-0,272
	-0,151
	0,042
	1
	0,233
	0,032
	-0,024
	0,350
	-0,150
	-0,483*
	-0,086
	0,163
	0,425*
	0,233

	
	Sig. (2-tailed)
	0,492
	0,326
	0,209
	0,492
	0,850
	
	0,284
	0,886
	0,912
	0,102
	0,495
	0,020
	0,696
	0,458
	0,043
	0,284

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_7
	Pearson Correlation
	0,215
	0,215
	0,280
	0,032
	0,233
	0,233
	1
	0,215
	-0,211
	-0,024
	0,233
	-0,285
	-0,086
	0,350
	0,233
	0,542**

	
	Sig. (2-tailed)
	0,326
	0,326
	0,195
	0,886
	0,284
	0,284
	
	0,326
	0,333
	0,912
	0,284
	0,188
	0,696
	0,102
	0,284
	0,008

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_8
	Pearson Correlation
	0,477*
	-0,045
	-0,137
	-0,220
	0,032
	0,032
	0,215
	1
	0,124
	-0,233
	0,215
	-0,255
	0,313
	-0,054
	0,215
	0,347

	
	Sig. (2-tailed)
	0,021
	0,837
	0,532
	0,314
	0,886
	0,886
	0,326
	
	0,573
	0,285
	0,326
	0,240
	0,147
	0,806
	0,326
	0,104

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_9
	Pearson Correlation
	-0,054
	-0,054
	0,016
	-0,054
	-0,398
	-0,024
	-0,211
	0,124
	1
	0,087
	0,350
	-0,143
	-0,143
	-0,095
	-0,024
	0,082

	
	Sig. (2-tailed)
	0,806
	0,806
	0,944
	0,806
	0,060
	0,912
	0,333
	0,573
	
	0,692
	0,102
	0,515
	0,515
	0,666
	0,912
	0,710

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_10
	Pearson Correlation
	-0,054
	-0,054
	0,195
	0,124
	-0,024
	0,350
	-0,024
	-0,233
	0,087
	1
	-0,211
	-0,143
	-0,337
	0,087
	-0,024
	0,157

	
	Sig. (2-tailed)
	0,806
	0,806
	0,372
	0,573
	0,912
	0,102
	0,912
	0,285
	0,692
	
	0,333
	0,515
	0,116
	0,692
	0,912
	0,474

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_11
	Pearson Correlation
	0,215
	0,215
	0,280
	0,032
	0,042
	-0,150
	0,233
	0,215
	0,350
	-0,211
	1
	0,112
	0,112
	0,350
	0,233
	0,619**

	
	Sig. (2-tailed)
	0,326
	0,326
	0,195
	0,886
	0,850
	0,495
	0,284
	0,326
	0,102
	0,333
	
	0,610
	0,610
	0,102
	0,284
	0,002

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_12
	Pearson Correlation
	0,123
	0,313
	-0,008
	-0,066
	0,112
	-0,483*
	-0,285
	-0,255
	-0,143
	-0,143
	0,112
	1
	0,179
	-0,143
	-0,285
	-0,003

	
	Sig. (2-tailed)
	0,575
	0,147
	0,970
	0,765
	0,610
	0,020
	0,188
	0,240
	0,515
	0,515
	0,610
	
	0,415
	0,515
	0,188
	0,987

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_13
	Pearson Correlation
	-0,255
	-0,066
	-0,008
	0,123
	0,112
	-0,086
	-0,086
	0,313
	-0,143
	-0,337
	0,112
	0,179
	1
	0,051
	-0,086
	0,156

	
	Sig. (2-tailed)
	0,240
	0,765
	0,970
	0,575
	0,610
	0,696
	0,696
	0,147
	0,515
	0,116
	0,610
	0,415
	
	0,819
	0,696
	0,476

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_14
	Pearson Correlation
	-0,233
	0,302
	0,195
	0,481*
	-0,024
	0,163
	0,350
	-0,054
	-0,095
	0,087
	0,350
	-0,143
	0,051
	1
	0,537**
	0,609**

	
	Sig. (2-tailed)
	0,285
	0,161
	0,372
	0,020
	0,912
	0,458
	0,102
	0,806
	0,666
	0,692
	0,102
	0,515
	0,819
	
	0,008
	0,002

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Soal_15
	Pearson Correlation
	0,215
	0,215
	-0,272
	0,032
	0,042
	0,425*
	0,233
	0,215
	-0,024
	-0,024
	0,233
	-0,285
	-0,086
	0,537**
	1
	0,504*

	
	Sig. (2-tailed)
	0,326
	0,326
	0,209
	0,886
	0,850
	0,043
	0,284
	0,326
	0,912
	0,912
	0,284
	0,188
	0,696
	0,008
	
	0,014

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	Jumlah
	Pearson Correlation
	0,237
	0,495*
	0,345
	0,274
	0,272
	0,233
	0,542**
	0,347
	0,082
	0,157
	0,619**
	-0,003
	0,156
	0,609**
	0,504*
	1

	
	Sig. (2-tailed)
	0,277
	0,016
	0,107
	0,206
	0,209
	0,284
	0,008
	0,104
	0,710
	0,474
	0,002
	0,987
	0,476
	0,002
	0,014
	

	
	N
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	*. Correlation is significant at the 0.05 level (2-tailed).

	**. Correlation is significant at the 0.01 level (2-tailed).



[bookmark: _Toc189750301]4.1.2 Reliabilitas
[bookmark: _Hlk189749982]Berdasarkan data yang diperoleh pada Lampiran 5, kemudian dilakukan pengolahan data menggunakan bantuan aplikasi SPSS untuk menentukan reliabilitas soal maka diperoleh hasil sebagai berikut:
[image: ]
[bookmark: _Toc182496811][bookmark: _Toc189750627][bookmark: _Toc179454122]Gambar 4.1 Nilai Reliabilitas Hasil Olahan SPSS
[bookmark: _Toc189750302]4.1.3 Tingkat Kesukaran
	Berdasarkan data yang diperoleh pada Lampiran 5, kemudian dilakukan pengolahan data menggunakan bantuan aplikasi SPSS untuk menentukan tingkat kesukaran butir soal maka diperoleh hasil sebagai berikut:
[bookmark: _Toc182496651][bookmark: _Toc182496761][bookmark: _Toc189750597]Tabel 4.2 Nilai Tingkat Kesukaran Hasil Olahan SPSS
	Statistics

	
	Soal_1
	Soal_2
	Soal_3
	Soal_4
	Soal_5
	Soal_6
	Soal_7
	Soal_8
	Soal_9
	Soal_10
	Soal_11
	Soal_12
	Soal_13
	Soal_14
	Soal_15

	N
	Valid
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23
	23

	
	Missing
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0
	0

	[bookmark: _Hlk182650173]Mean
	0,52
	0,52
	0,57
	0,52
	0,65
	0,65
	0,65
	0,52
	0,61
	0,61
	0,65
	0,70
	0,70
	0,61
	0,65



[bookmark: _Toc189750303]4.1.4 Daya Pembeda
	Berdasarkan data yang diperoleh pada Lampiran 5, kemudian dilakukan pengolahan data menggunakan bantuan aplikasi SPSS untuk menentukan daya pembeda soal maka diperoleh hasil sebagai berikut:
[bookmark: _Toc182496652][bookmark: _Toc182496762][bookmark: _Toc189750598]Tabel 4.3 Nilai Daya Pembeda Hasil Olahan SPSS
	Item-Total Statistics

	
	Scale Mean if Item Deleted
	Scale Variance if Item Deleted
	Corrected Item-Total Correlation
	Cronbach's Alpha if Item Deleted

	Soal_1
	8,61
	5,522
	0,026
	0,411

	Soal_2
	8,61
	4,885
	0,310
	0,324

	Soal_3
	8,57
	5,257
	0,143
	0,377

	Soal_4
	8,61
	5,431
	0,065
	0,400

	Soal_5
	8,48
	5,443
	0,073
	0,397

	Soal_6
	8,48
	5,534
	0,033
	0,408

	Soal_7
	8,48
	4,806
	0,376
	0,306

	Soal_8
	8,61
	5,249
	0,144
	0,376

	Soal_9
	8,52
	5,897
	-0,124
	0,451

	Soal_10
	8,52
	5,715
	-0,050
	0,431

	Soal_11
	8,48
	4,625
	0,470
	0,276

	Soal_12
	8,43
	6,075
	-0,194
	0,465

	Soal_13
	8,43
	5,711
	-0,039
	0,426

	Soal_14
	8,52
	4,625
	0,453
	0,279

	Soal_15
	8,48
	4,897
	0,330
	0,321



[bookmark: _Toc189750304]4.1.5 Efektifitas Pengecoh
	Berdasarkan uji instrumen 15 butir soal yang dilakukan ke 23 orang peserta didik diperoleh jawaban yang akan ditunjukkan pada tabel berikut ini:
[bookmark: _Toc182496653][bookmark: _Toc182496763][bookmark: _Toc189750599]Tabel 4.4 Kunci Jawaban Instrumen Soal dan Jawaban Siswa
	No
	Nama Siswa 
	Kunci Jawaban Soal

	
	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15

	
	
	A
	A
	A
	A
	A
	B
	D
	C
	D
	C
	D
	C
	B
	C
	B

	1
	Alya Ramadhani
	A
	A
	A
	B
	A
	D
	D
	C
	A
	B
	D
	C
	B
	A
	A

	2
	Arina
	A
	A
	D
	C
	A
	B
	D
	C
	D
	B
	D
	C
	B
	C
	B

	3
	Raisya
	A
	C
	A
	A
	A
	B
	D
	C
	D
	C
	D
	D
	B
	C
	B

	4
	Arfan
	A
	A
	A
	A
	A
	B
	D
	C
	B
	C
	D
	C
	B
	C
	B

	5
	Atixa Laila
	B
	A
	A
	A
	A
	B
	D
	A
	D
	C
	D
	C
	B
	C
	B

	6
	Zahia Widiasi
	A
	A
	C
	B
	A
	B
	D
	A
	C
	B
	D
	C
	A
	C
	B

	7
	Atifa
	A
	B
	A
	C
	B
	C
	B
	C
	D
	C
	D
	C
	B
	A
	D

	8
	Danang 
	C
	A
	A
	A
	D
	B
	D
	D
	D
	C
	D
	A
	C
	C
	B

	9
	Karin
	B
	A
	A
	A
	A
	D
	D
	C
	D
	B
	D
	C
	B
	C
	A

	10
	Heri
	A
	A
	D
	C
	B
	B
	C
	C
	D
	C
	C
	C
	D
	A
	B

	11
	Delvi Zahira
	A
	C
	A
	A
	A
	C
	D
	D
	A
	C
	D
	C
	A
	C
	B

	12
	Karin Fadila
	A
	A
	A
	D
	A
	B
	D
	C
	D
	C
	D
	A
	D
	C
	B

	13
	Mutiara Tarigan
	A
	C
	D
	A
	A
	A
	A
	A
	D
	C
	D
	C
	A
	D
	A

	14
	Daffa
	A
	B
	B
	C
	C
	A
	D
	C
	D
	B
	D
	C
	B
	C
	B

	15
	Faireh
	B
	D
	A
	A
	A
	A
	C
	D
	A
	D
	A
	C
	B
	B
	D

	16
	Tien
	D
	D
	A
	C
	B
	B
	D
	B
	D
	A
	D
	B
	A
	D
	A

	17
	Anggun
	A
	D
	B
	D
	A
	B
	D
	C
	D
	B
	C
	B
	B
	C
	B

	18
	Atifa Zahira
	B
	C
	D
	B
	A
	B
	A
	A
	D
	C
	D
	C
	B
	C
	A

	19
	Meghrima Azola
	B
	D
	B
	A
	B
	B
	B
	C
	D
	D
	D
	A
	B
	C
	B

	20
	Naira
	C
	A
	A
	A
	D
	B
	D
	B
	C
	C
	B
	C
	B
	C
	A

	21
	Reysa Ilfa
	C
	A
	A
	A
	D
	A
	B
	B
	D
	D
	D
	C
	B
	C
	B

	22
	Adira
	D
	C
	D
	A
	A
	B
	D
	C
	D
	C
	B
	B
	B
	C
	B

	23
	Raziv
	B
	A
	B
	D
	A
	B
	B
	D
	B
	C
	B
	C
	B
	C
	B


 
	Pada penelitian ini, efektifitas pengecoh dihitung secara manual menggunakan bantuan dari Microsoft Excel. Berdasarkan tabel diatas dari total 60 opsi jawaban yang ada pada 15 butir soal yang menjadi istrumen penelitian diperoleh 1 opsi pengecoh dengan kualitas buruk (ditolak), 7 opsi dengan kualitas kurang baik (direvisi), dan 52 opsi pengecoh dengan kualitas baik.
[bookmark: _Toc189750305]4.2 Pembahasan
[bookmark: _Toc189750306]4.2.1 Analisis Validitas
	Pada penelitian ini, validitas soal ditentukan dengan menggunakan bantuan aplikasi SPSS. Arikunto (2010) menyatakan bahwa suatu butir soal dikatakan valid apabila nilai  (Riyani et al., 2017). Untuk menentukan nilai  aplikasi SPSS dapat digunakan sebagai alat bantu menentukan nilai validitas, hasil olahan SPSS pada Tabel 4.1 diperoleh melalui langkah-langkah sebagai berikut:
1. Buka aplikasi SPSS;
2. Klik menu Variable View;
3. Pada kolom Name ganti dan sesuaikan nama sesuai instrumen yang diinginkan;
4. Pada kolom Decimals, ganti menjadi 0 seluruhnya;
5. Klik Data View;
6. Input data yang ada pada Lampiran 5 seluruhnya;
7. Klik Analyze  Correlate  Bivariate;
8. Pada menu Bivariate Correlations pilih semua nama instrumen kemudian lalu pindahkan ke kolom Variables; klik OK.
	Jika langkah-langkah tersebut sudah dilakukan, akan diperoleh hasil output seperti pada Tabel 4.1. Berdasarkan tabel tersebut nilai  pada masing-masing butir soal dapat dilihat pada kolom Jumlah tepatnya pada kolom Pearson Correlation pada masing-masing soal. Sedangkan untuk menentukan nilai  ditentukan berdasarkan tabel berikut:
[image: ]
[bookmark: _Toc189750628]Gambar 4.2 Tabel 
Penentuan nilai  disesuaikan dengan jumlah responden dikurangi 2 atau disebut dengan derajat kebebasan , dimana  kemudian menentukan nilainya dengan menggunakan level signifikansi 5% atau 0,05 maka diperoleh nilai . Selain dengan memperhatikan kolom Pearson Correlation pada Tabel 4.1, alternatif lain untuk menentukan nilai validitas soal adalah dengan melihat kolom Jumlah tepatnya pada kolom Sig. (2-tailed). Ghozali (2011) mengungkapkan jika nilai nilai signifikansi atau sig. < 0,05 berarti data valid dan jika nilai signifikansi atau sig. > 0,05 berarti data tidak valid. Dengan demikian validitas soal yang menjadi instrumen penelitian ini didistribusikan pada tabel berikut:
[bookmark: _Toc189750600]Tabel 4.5 Distribusi Validitas Butir Soal
	Nomor Soal
	
(Pearson Correlation)
	
	Sig. (2-tailed)
	Kesimpulan

	1
	0,237
	0,433
	0,277
	Tidak Valid

	2
	0,495
	0,433
	0,016
	Valid

	3
	0,345
	0,433
	0,107
	Tidak Valid

	4
	0,274
	0,433
	0,206
	Tidak Valid

	5
	0,272
	0,433
	0,209
	Tidak Valid

	6
	0,233
	0,433
	0,284
	Tidak Valid

	7
	0,542
	0,433
	0,008
	Valid

	8
	0,347
	0,433
	0,104
	Tidak Valid

	9
	0,082
	0,433
	0,710
	Tidak Valid

	10
	0,157
	0,433
	0,474
	Tidak Valid

	11
	0,619
	0,433
	0,002
	Valid

	12
	- 0,003
	0,433
	0,987
	Tidak Valid

	13
	0,156
	0,433
	0,476
	Tidak Valid

	14
	0,609
	0,433
	0,002
	Valid

	15
	0,504
	0,433
	0,014
	Valid



	Berdasarkan tabel diatas, dapat diketahui bahwa 5 (33,3%) dari 15 soal valid dan 10 (66,7%) soal tidak valid dan kurang layak digunakan pada sampel penelitian. 
[bookmark: _Toc189750307]4.2.2 Analisis Reliabilitas
	Keakuratan atau keandalan suatu instrumen yang digunakan untuk mengukur secara berulang kali dan tetap memberikan hasil yang sama dikatakan sebagai reliabilitas. Sebuah instrumen/alat ukur dikatakan reliabel jika nilai Chronbach’s Alpha bernilai  (Sugiyono, 2017). Janna & Herianto (2021) mengungkapkan reliabilitas dapat diuji menggunakan beberapa metode yakni Tes Ulang, Formula Flanagan, Chronbach’s Alpha, Formula Kuder-Richardson, dan Anova Hoyt. Pada penelitian ini, hasil olahan SPSS pada Gambar 4.1 diperoleh melalui langkah-langkah berikut:
1. Buka aplikasi SPSS;
2. Klik menu Variable View;
3. Pada kolom Name ganti dan sesuaikan nama sesuai instrumen yang diinginkan;
4. Pada kolom Decimals, ganti menjadi 0 seluruhnya;
5. Klik Data View;
6. Input data yang ada pada Lampiran 5seluruhnya;
7. Klik Analyze  Scale  Reliability Analysis;
8. Pada menu Reliability Analysis pilih semua nama instrumen kecuali Jumlah kemudian pindahkan ke kolom Items; klik OK.
	Langkah-langkah tersebut akan menghasilkan output berupa hasil nilai Chronbach’s Alpha seperti Gambar 4.1 sebesar   atau  sehingga dapat dikatakan bahwa instrumen penelitian yang digunakan tidak reliabel atau tidak direkomendasikan untuk menggunakan instrumen secara berulang.
[bookmark: _Toc189750308]4.2.3 Analisis Tingkat Kesukaran
	Analisis tingkat kesukaran instrumen soal digunakan untuk mengklasifikasikan tingkat kesukaran soal berdasarkan jawaban siswa. Semakin kecil indeks tingkat kesukaran yang diperoleh, makin sulit soal tersebut dan semakin besar indeks yang diperoleh, makin mudah soal tersebut. Hasil olahan SPSS pada Tabel 4.2 diperoleh melalui langkah-lagkah berikut:
1. Buka aplikasi SPSS;
2. Klik menu Variable View;
3. Pada kolom Name ganti dan sesuaikan nama sesuai instrumen yang diinginkan;
4. Pada kolom Decimals, ganti menjadi 0 seluruhnya;
5. Klik Data View;
6. Input data yang ada pada Lampiran 5 seluruhnya;
7. Klik Analyze  Descriptive Statistics  Frequencies;
8. Pada menu Frequencies pilih semua nama instrumen kecuali Jumlah kemudian pindahkan ke kolom Variable(s); 
9. Klik Statistics; Pada menu Central Tendency centang pada Mean; klik Continue; klik OK.
	Hasil pada Tabel 4.2 menunjukkan nilai indeks tingkat kesukaran masing-masing soal. Indeks tingkat kesukaran dapat dilihat pada kolom Mean pada masing-masing soal sehingga distribusi tingkat kesukaran dapat dilihat pada tabel berikut:
[bookmark: _Toc189750601]Tabel 4.6 Distribusi Tingkat Kesukaran Soal
	Nomor Soal
	Nilai Mean 
(Indeks Kesukaran)
	Tingkat Kesukaran

	1
	0,52
	Sedang

	2
	0,52
	Sedang

	3
	0,57
	Sedang

	4
	0,52
	Sedang

	5
	0,65
	Sedang

	6
	0,65
	Sedang

	7
	0,65
	Sedang

	8
	0,52
	Sedang

	9
	0,61
	Sedang

	10
	0,61
	Sedang

	11
	0,65
	Sedang

	12
	0,70
	Sedang

	13
	0,70
	Sedang

	14
	0,61
	Sedang

	15
	0,65
	Sedang



	Berdasarkan tabel diatas, dapat disimpulkan bahwa 15 butir soal yang menjadi instrumen penelitian memiliki kriteria kesukaran soal sedang tidak terlalu sulit dan tidak terlalu mudah.
[bookmark: _Toc189750309]4.2.4 Analisis Daya Pembeda
	Analisis daya pembeda diperlukan guna mencari tahu perbedaan antara siswa yang memiliki kemampuan yang tinggi dengan siswa yang memiliki kemampuan rendah dalam menyelesaikan soal instrumen tersebut. Hasil olahan SPSS pada Tabel 4.3 diperoleh melalui langkah-langkah berikut:
1. Buka aplikasi SPSS;
2. Klik menu Variable View;
3. Pada kolom Name ganti dan sesuaikan nama sesuai instrumen yang diinginkan;
4. Pada kolom Decimals, ganti menjadi 0 seluruhnya;
5. Klik Data View;
6. Input data yang ada pada Lampiran 5 seluruhnya;
7. Klik Analyze  Scale  Reliability Analysis;
8. Pada menu Reliability Analysis pilih semua nama instrumen kecuali Jumlah kemudian pindahkan ke kolom Items;
9. Klik menu Statistics; Pada kolom Descriptives for centang menu Item, Scale, Scale if Item Deleted; klik Continue; Klik OK.
	Hasil output SPSS sesuai langkah tersebut analisis menampilkan 4 kolom dan nilai daya pembeda ditentukan dengan memperhatian kolom Corrected Item-Total Correlation lalu mengklasifikasikannya dengan kriteria daya pembeda.
	Berdasarkan Tabel 4.3 dan kriteria diatas, distribusi daya pembeda instrumen penelitian ini ditunjukkan oleh tabel berikut:
[bookmark: _Toc189750602]Tabel 4.7 Distribusi Tingkat Kesukaran Soal
	No. Soal
	Nilai Corrected Item-Total Correlation
	Kesimpulan

	1
	0,026
	Daya Pembeda Jelek

	2
	0,310
	Daya Pembeda Cukup

	3
	0,143
	Daya Pembeda Jelek

	4
	0,065
	Daya Pembeda Jelek

	5
	0,073
	Daya Pembeda Jelek

	6
	0,033
	Daya Pembeda Jelek

	7
	0,376
	Daya Pembeda Cukup

	8
	0,144
	Daya Pembeda Jelek

	9
	-0,124
	Daya Pembeda Sangat Jelek

	10
	-0,050
	Daya Pembeda Sangat Jelek

	11
	0,470
	Daya Pembeda Baik

	12
	-0,194
	Daya Pembeda Sangat Jelek

	13
	-0,039
	Daya Pembeda Sangat Jelek

	14
	0,453
	Daya Pembeda Baik

	15
	0,330
	Daya Pembeda Cukup


 	
Berdasarkan tabel diatas, dapat disimpulkan dari 15 butir soal yang menjadi instrumen penelitian memiliki 4 butir dengan daya pembeda Sangat Jelek, 6 butir dengan daya pembeda Jelek atau tidak dapat membedakan kemampuan siswa yang tinggi dan kemampuan siswa yang rendah, 3 butir dengan daya pembeda Cukup, dan 2 butir dengan daya pembeda Baik atau dapat digunakan untuk membedakan kemampuan siswa yang tinggi dan kemampuan siswa yang rendah.
[bookmark: _Toc189750310]4.2.5 Analisis Efektifitas Pengecoh
Efektivitas pengecoh atau distraktor dimaksudkan sebagai kemampuan opsi yang dipakai pada soal pilihan berganda untuk mengecoh peserta tes dalam memilih jawaban yang benar. Pada penelitian ini efektifitas pengecoh diolah secara manual menggunakan bantuan Microsoft Excel. Berdasarkan hasil jawaban siswa pada Tabel 4.4 kemudian diolah menggunakan bantuan Microsoft Excel dengan menggunakan langkah-langkah sebagai berikut:
1. Buka Microsoft Excel;
2. Isi data sesuai Tabel 4.5;
3. Tentukan opsi jawaban yang dipilih siswa pada masing-masing soal yang disusun kedalam tabel berikut:
[bookmark: _Toc189750603]Tabel 4.8 Distribusi Opsi Jawaban Yang Dipilih Siswa Pada Tiap Soal
	No
	Jawaban
	Nomor Soal 

	
	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15

	1
	A
	12
	12
	13
	12
	15
	4
	2
	4
	3
	1
	1
	3
	4
	3
	6

	2
	B
	6
	2
	4
	3
	4
	15
	4
	3
	2
	6
	3
	3
	16
	1
	15

	3
	C
	3
	5
	1
	5
	1
	2
	2
	12
	2
	13
	2
	16
	1
	17
	0

	4
	D
	2
	4
	5
	3
	3
	2
	15
	4
	16
	3
	17
	1
	2
	2
	2



4. Selanjutnya menentukan persentase dengan cara membandingkannya dengan seluruh (23 orang) peserta tes. 
5. Hasil yang diperoleh dengan rumus tersebut kemudian disesuaikan dengan kriteria efektifitas pengecoh berikut:
, Diterima (baik)
, Revisi dengan ditulis kembali (kurang baik)
, Ditolak (tidak baik)
Dengan demikian, persentase tingkat pengecoh dari masing-masing soal dapat ditentukan dan akan ditampilkan oleh tabel berikut:
[bookmark: _Toc189750604]Tabel 4.9 Distribusi Persentase Tingkat Pengecoh
	No
	Jawaban
	Nomor Soal 

	
	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15

	1
	A
	52%
	52%
	57%
	52%
	65%
	17%
	9%
	17%
	13%
	4%
	4%
	13%
	17%
	13%
	26%

	2
	B
	26%
	9%
	17%
	13%
	17%
	65%
	17%
	13%
	9%
	26%
	13%
	13%
	70%
	4%
	65%

	3
	C
	13%
	22%
	4%
	22%
	4%
	9%
	9%
	52%
	9%
	57%
	9%
	70%
	4%
	74%
	0%

	4
	D
	9%
	17%
	22%
	13%
	13%
	9%
	65%
	17%
	70%
	13%
	74%
	4%
	9%
	9%
	9%



Berdasarkan tabel diatas yang kemudian kita compare dengan kriteria efektifitas pengecoh maka diperoleh hasil sebagai berikut:
[bookmark: _Toc189750605]Tabel 4.10 Distribusi Efektifitas Pengecoh Tiap Butir Soal
	No
	Opsi Jawaban
	Nomor Soal

	
	
	Diterima
	Revisi
	Ditolak

	1
	A
	1,2,3,4,5,6,7,8,9,12,13,14,15
	10,11
	-

	2
	B
	1,2,3,4,5,6,7,8,9,10,11,12,13,15
	14
	-

	3
	C
	1,2,4,6,7,8,9,10,11,12,14
	13
	15

	4
	D
	1,2,3,4,5,6,7,8,9,10,11,13,14,15
	12
	-



	Berdasarkan tabel diatas, dapat disimpulkan bahwa 60 opsi jawaban yang diberikan pada 15 butir soal hanya ada 1 opsi yang sebaiknya tidak digunakan lagi atau diganti dengan opsi yang lain.
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[bookmark: _Toc189750311]BAB V
[bookmark: _Toc189750312]SIMPULAN DAN SARAN

[bookmark: _Toc189750313]5.1 Kesimpulan 
	Berdasarkan hasil Analisis Soal Tes Belajar Siswa Dalam Pembelajaran Matematika Pada Bilangan Cacah Kelas IV di SD Negeri 104218 Sidomulyo meliputi validitas, reliabilitas, tingkat kesukaran, daya pembeda serta efektifitas pengecoh dapat disimpulkan bahwa:
1. [bookmark: _Hlk185323875]Validitas instrumen soal terdiri dari 5 soal dikatakan valid sedangkan 10 soal lainnya tidak valid.
2. Reliabilitas pada instrumen soal pada penelitian ini bernilai  sehingga instrumen soal pada penelitian ini dikatakan tidak reliabel.
3. Tingkat kesukaran instrumen soal pada penelitian ini yang terdiri dari 15 butir soal keseluruhannya terletak pada kategori Sedang.
4. Daya pembeda instrumen soal pada penelitian ini terdiri dari 4 butir soal Sangat Jelek, 6 butir soal memiliki daya pembeda Jelek, 3 butir soal memiliki daya pembeda Cukup, 2 butir soal memiliki daya pembeda Baik.
5. Efektifitas pengecoh pada penelitian ini hampir seluruhnya dapat Diterima, hanya beberapa opsi yang harus Direvisi, dan hanya satu opsi yang Ditolak dari keseluruhan opsi yang ada pada instrumen soal.
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[bookmark: _Toc189750314]5.2 Saran 
Analisis soal tes cukup perlu untuk dilakukan sebagai evaluasi para pendidik dikarenakan kegiatan ini tidak hanya menambah wawasan serta ilmu pengetahuan melainkan dapat menggambarkan kemampuan peserta didik yang dibina, selain itu kegiatan ini juga dapat digunakan sebagai alat untuk melihat perbedaan kemampuan dari peserta didik yang ada di kelas kita. Untuk itu, kegiatan analisis ini ada baiknya dijadikan sebagai kegiatan inti dalam penerapan pembelajaran di sekolah. 
Kegiatan analisis ini memang cukup sulit untuk dilakukan walaupun  begitu ada cukup banyak alat bantu yang dapat digunakan untuk melakukan kegiatan analisis salah satunya adalah Software SPSS aplikasi lain yang dapat digunakan adalah aplikasi yang sangat umum dalam pengolahan data yakni Micrososft Excel sehingga tidak ada alasan bagi kita untuk tidak melakukan kegiatan analisis.
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[bookmark: _Toc189750658]Lampiran 1. Instrumen Observasi Wawancara Guru

Nama Sekolah			: SD NEGERI NO:104218 SIDOMULYO 
Alamat Sekolah		: Sidomulyo, Kec, Biru-biru 
Nama Guru			: 
Hari/Tanggal Wawancara	: 

	No.
	Pertanyaan
	Jawaban

	1.
	Metode apa saja yang bapak/ibu berikan dalam menyampaikan materi pembelajaran agar semua siswa mampu mengikuti pembelajaran dengan baik?
	metode deskriptif

	2.
	Apakah metode tersebut efektif?
	Ya metodenya efektif 

	3.
	Sampai dimana materi pembelajaran matematika yang diajarkan saat ini dan buku pedoman apa yang digunakan?
	Materi bilangan cacah di kelas 4, Buku yang digunakan esensi matematika 

	4.
	Apakah bapak/ibu pernah melakukan evaluasi terhadap soal pilihan berganda pada materi tersebut ?
	Guru jarang melakukan kegiatan analisis, kegiatan tersebut cukup banyak ditemukan kendala seperti waktu

	5.
	Jenis evaluasi apa yang bapak/ibu gunakan?
	Evaluasi bentuk tes

	6.
	Dari sumber mana kira-kira saya bisa memperoleh soal-soal instrumen penelitian tersebut?
	Bisa dari buku pedoman guru

	7.
	Jika diizinkan, berapa banyak soal pilihan berganda dari materi tersebut yang tepat untuk saya gunakan sebagai instrumen penelitian?
	Bisa 15 butir soal 

	8.
	Apabila saya ingin melakukan kegiatan evaluasi dengan materi pembelajaran yang ada saat ini sebagai topik penelitian apakah bapak/ibu mengizinkan?
	Ya,diizinkan 

	9.
	Kelas mana yang cocok untuk saya jadikan sebagai sampel penelitian?
	Kelas lv Skolah Dasar Negri  104218 Sidomulyo 
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[bookmark: _Toc189750659]Lampiran 2. Kisi-Kisi Instrumen Soal
Mata Pelajaran	: Matematika
Kelas/Kurikulum	: IV/Merdeka
	No.
	Materi
	Capaian Pembelajaran
	Indikator Soal
	Level Kognitif
	Nomor Soal

	1.
	Bilangan Cacah  sampai puluhan ribu
	Penjumlahan dan pengurangan bilangan cacah
	Diberikan soal operasi hitung campuran dengan nilai puluhan ribu kemudian menentukan hasilnya
	C1,C2
	1

	2.
	Pecahan Biasa
	Mengubah bentuk macam-macam pecahan
	Diberikan soal pecahan kemudian diubah ke bentuk persen
	C1, C2
	2

	
	
	
	Diberikan soal pecahan kemudian diubah ke bentuk desimal
	C1, C2
	3

	
	
	
	Diberikan soal persen kemudian diubah ke bentuk desimal
	C1, C2
	5

	
	
	Membandingkan pecahan
	Diberikan soal perbandingan besar kecil antar pecahan
	C1, C2
	4

	
	
	
	Diberikan soal perbandingan senilai dengan pecahan biasa
	C2, C3
	14

	
	
	
	Diberikan soal perbandingan bilangan cacah kemudian menghitung jumlah dari perbandingan
	C3
	15

	3.
	Pecahan Campuran
	Menentukan hasil penjumlahan dan pengurangan macam-macam pecahan
	Diberikan soal penjumlahan pecahan campuran dan pecahan biasa
	C1, C2, C3
	6, 13

	
	
	
	Diberikan soal penjumlahan dan pengurangan pecahan campuran, persen, dan desimal
	C1, C2
	7, 8, 9

	
	
	Menentukan hasil perkalian dan pembagian macam-macam pecahan
	Diberikan soal perkalian dan pembagian epcahan campuran, persen, dan desimal
	C1, C2
	10, 11, 12

	4.
	Taksiran
	Menentukan taksiran terdekat
	Diberikan soal penjumlahan dan pengurangan bilangan cacah kemudian taksir ke puluhan, ratusan, atau ribuan terdekat
	C3
	16, 18, 19, 21, 22, 23

	
	
	
	Diberikan soal perkalian dan pembagian bilangan cacah kemudian taksir ke puluhan, ratusan, atau ribuan terdekat
	C3
	17, 20

	5.
	Pembulatan 
	Menentukan pembulatan terdekat
	Diberikan soal perkalian dan pembagian bilangan cacah kemudian bulatkan ke puluhan dan ribuan terdekat
	C3
	24, 25



[bookmark: _Toc189750660]Lampiran 3. Instrumen Soal Bilangan Cacah

Pilihlah salah satu jawaban yang paling tepat menggunakan tanda silang 

1. 
2. Hasil dari  ...
a. 53500	c. 14500
b. 10500	d. 20500

3. Bentuk persen dari  adalah . . .
a. 15% 		c. 20%
b. 10% 		d. 16%

4. Bentuk pecahan desimal dari  adalah…
a. 0,65 		c. 6,05
b. 0,605 	d. 60,5

5. Tanda perbandingan dari pecahan  dengan 63% yang tepat adalah . .
a. > 		c. <
b. = 		d. ≤

6. 38% dari siswa kelas V adalah perempuan. Jika ditulis ke dalam bentuk desimal adalah . . .
a. 3,8 		c. 0,038
b. 0,38 		e. 0,0038

7. [bookmark: _Hlk169966473]Hasil penjumlahan dari  adalah . . .
a.  		c. 
b.  		d. 

8. Hasil penjumlahan dari 0,75 - 27% adalah....
a. 4,08 		c. 04,8
b. 48,0 		d. 0,48

9. Hasil penjumlahan dari 0,540 - 0,3 adalah....
a. 024,0 	c. 0,240
b. 02,40 	d. 0,402

10. Hasil dari  x  adalah . . .
a.  		c. 
b. 		d. 

11. Hasil dari 45% : 6/7 adalah . . .
a. 05,25		c. 0,525
b. 052,5		d. 525

12. Perbandingan 5/4 senilai dengan . . .
a. 5 : 9		c. 5 : 8
b. 10 : 4		d. 10 : 8

13. Taksiran dari 632 + 486 kira-kira ....
a. 900		c. 1.100
b. 1.000		d. 1.200
14. Hasil perkalian 24 dan 75 jika dibulatkan ke ribuan terdekat menjadi ....
a. 1.000		c. 3.000
b. 2.000		d. 4.000

15. 25.672 + 1.250 = ....
Taksiran dalam ratusan terdekat dari operasi hitung di atas adalah ....
a. 26.800	c. 26.000
b. 27.800	d. 27.000

16. Hasil pengurangan dari 1.578 dari 5.342 jika dibulatkan ke ratusan terdekat menjadi....
a. 3.700		c. 3.00
b. 3.800		d. 4.000
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Lampiran 5. Distribusi Jawaban Benar dan Salah Siswa dari Tiap Butir Soal
	No
	Nama Siswa 
	Butir Instrumen Soal
	Jlh


	
	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	

	1
	Alya Ramadhani
	1
	1
	1
	0
	1
	0
	1
	1
	0
	0
	1
	1
	1
	0
	0
	9

	2
	Arma
	1
	1
	0
	0
	1
	1
	1
	1
	1
	0
	1
	1
	1
	0
	1
	11

	3
	Rasiya
	1
	0
	1
	1
	1
	1
	1
	1
	1
	1
	1
	0
	1
	1
	1
	13

	4
	Arfan
	1
	1
	1
	1
	1
	1
	1
	1
	0
	1
	1
	1
	1
	1
	1
	14

	5
	Atixa Laila
	0
	1
	1
	1
	1
	1
	1
	0
	1
	1
	1
	1
	1
	1
	1
	13

	6
	Zahia Widiasi
	1
	1
	0
	0
	1
	1
	1
	0
	0
	0
	1
	1
	0
	1
	1
	9

	7
	Atifa
	1
	0
	1
	0
	0
	0
	0
	1
	1
	1
	1
	1
	1
	0
	0
	8

	8
	Danang 
	0
	1
	1
	1
	0
	1
	1
	0
	1
	1
	1
	0
	0
	1
	1
	10

	9
	Karin
	0
	1
	1
	1
	1
	0
	1
	1
	1
	0
	1
	1
	1
	1
	0
	11

	10
	Heri
	1
	1
	0
	0
	0
	1
	0
	1
	1
	1
	0
	1
	0
	0
	1
	8

	11
	Delvi Zahira
	1
	0
	1
	1
	1
	0
	1
	0
	0
	1
	1
	1
	0
	1
	1
	10

	12
	Karin Fadila
	1
	1
	1
	0
	1
	1
	1
	1
	1
	1
	1
	0
	0
	1
	1
	12

	13
	Mutiara Tarigan
	1
	0
	0
	1
	1
	0
	0
	0
	1
	1
	0
	1
	0
	0
	0
	6

	14
	Daffa
	1
	0
	0
	0
	0
	0
	1
	1
	1
	0
	1
	1
	1
	1
	1
	9

	15
	Faireh
	0
	0
	1
	1
	1
	0
	0
	0
	0
	0
	0
	1
	1
	0
	0
	5

	16
	Tien
	0
	0
	1
	0
	0
	1
	1
	0
	1
	1
	0
	0
	0
	0
	0
	5

	17
	Anggun
	1
	0
	0
	0
	1
	1
	1
	1
	0
	0
	0
	0
	1
	0
	1
	7

	18
	Atifa Zahira
	0
	0
	0
	0
	1
	1
	0
	0
	1
	1
	1
	1
	1
	0
	0
	7

	19
	Meghrima Azola
	0
	0
	0
	1
	0
	1
	0
	1
	1
	0
	1
	0
	1
	1
	1
	8

	20
	Naira
	0
	1
	1
	1
	0
	1
	1
	0
	0
	1
	0
	1
	1
	1
	0
	9

	21
	Raya Ilfa
	0
	1
	1
	1
	0
	0
	0
	0
	1
	0
	1
	1
	1
	1
	1
	9

	22
	Adira
	0
	0
	0
	1
	1
	1
	1
	1
	0
	1
	0
	0
	1
	1
	1
	9

	23
	Raziv
	0
	1
	0
	0
	1
	1
	0
	0
	0
	1
	0
	1
	1
	1
	1
	8



Catatan: Jawaban benar diisi dengan nilai 1 dan jawaban salah diisi dengan nilai 0
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ABSTRAK

ANALISIS SOAL TES BELAJAR SISWA DALAM
PEMBELAJARAN MATEMATIKA PADA BILANGAN CACAH
KELAS IV
DI SD NEGERI 104218 SIDOMULYO

Riza Wita Panjaitan

NPM. 201434224

bertujuan untuk mengetahui v:
kesukaran, daya pembeda, dan efektivitas pengecoh pada soal
berganda matematika materi bilangan cacah kelas IV SDN 104218
Sidomulyo sebanyak 15 soal. Penelitian ini merupakan penelitian kuantitatif
metode deskriptif. Populasi pada penelitian ini berjumlah 42 orang, sedangkan
sampel berjumlah 23 orang. Instrumen penelitian adalah 15 soal pilihan berganda
matematika kelas IV materi bilangan cacah. Analisis data dilakukan dengan
bantuan Software SPSS dan Microsoft Excel. Hasil penelitian diperoleh 5 soal
(33,3%) valid dan 10 soal (66,7%) tidak valid, instrumen soal bemilai < 0,6
sehingga tidak reliabel, 15 soal memiliki tingkat kesukaran sedang, daya pembeda
instrumen soal beragam yakni 4 soal dengan kriteria sangat jelek, 6 soal dengan
kriteria jelek, 3 soal dengan kriteria cukup, 2 soal dengan kriteria baik, serta
efektifitas pengecoh pada instrumen soal hanya beberapa yang direvisi dan hanya
satu opsi yang ditolak/diganti.

Kata Kunci: Validias, Reliabilitas, Daya Pembeda, Efektivitas Pengecoh, SPSS





image16.jpeg
——

INSTRUMEN SOAL

e ACEML
Kelas H N
Hari/Tanggal & oo
Materi : Bilangan Cacah

pilihlah salah satu jawaban yang paling
tepat menggunakan tanda silang (x)

1.

Hasil dari 39.700 + 63799 - 49,999

@/ 53500

c. 14500
b. 10500 d. 20500
Bentuk persen dari % adalah . .
w 15% €.20%
b. 10% d. 16%

Bentuk pecahan desimal dari 2
20
adalah...

0,65 ¢. 6,05
b. 0,605 d. 60,5

Tanda perbandingan dari pecahan ?
dengan 63% yang tepat adalah . .

> c.<
b = d=<

. 38% dari siswa kelas V adalah

perempuan. Jika ditulis ke dalam
bentuk desimal adalah . . .

w 3,8 ¢. 0,038

b. 0,38 ¢. 0,0038

Hasil penjumlahan dari 43+ 2

adalah . ..
5

a 4

2

M 42

2

c. 4-5

4

3 ]
Hasil penjumlahan dari 0,75 - 27%
adalah....
a. 4,08
b. 48,0

04,8
0,48

8. Hasil penjumlahan dari 0,540 - 0,3
adalah....
a. 0240
b. 02,40

0€,0,240
d. 0,402

9. Hasil dari 2x 12 adalah . ..

15 17
16
w2 43

10. Hasil dari 45% : 6/7 adalah . , .

a. 0525 o 0,525
b. 052,5 d. 525

11. Perbandingan 5/4 senilai dengan . . .
a 5:9 c.5:8
b. 10:4 > 10:8

12. Taksiran dari 632 + 486 kira-kira ....
a. 900 pe 1.100
b. 1.000 d. 1.200

13. Hasil perkalian 24 dan 75 jika
dibulatkan ke ribuan terdekat menjadi
a. 1.000
= 2.000

¢.3.000
d. 4.000

14.25.672+1.250=....
Taksiran dalam ratusan terdekat dari
operasi hitung di atas adalah ....
a. 26.800 >e; 26.000
b. 27.800 d. 27.000

15. Hasil pengurangan dari 1.578 dari
5.342 jika dibulatkan ke ratusan

terdekat menjadi....
a. 3.700 ¢. 3.000
b 3.800 d. 4.000

Dipindai dengan CamScanner




image17.jpeg




image18.jpeg




image19.jpeg




image20.jpeg




image21.jpeg




image22.jpeg




image23.jpeg




image24.jpeg
— o





image25.jpeg
ad Yunus Karim : JI. Garu fl No. 02,
Desa Suka Mandi Hili Kec. Pagar Merbas, Lubuk Pakam

W.ac.id Email : info@umnaw.ac.id

Telp. (061) : . Kampus Azidin:
1P- (061) 7867044 Medan 20147 g pa:,m.',:l:;:?;“ Ferbmungan
 http:/ /s, umna

i FORM. F. 1

Kepada Yth. Bapak/Ibu Ketua Program Studi
perihal  : Permohonan Persetujuan Judul

Dengan hormat, yang bertandatangan di bawah ini :

Nama Mahasiswa : Riza Wita Panjaitan
NPM 1201434224
Jurusan/Prog. Studi  : [P/PGSD

Kredit Kumulatif :3.51

No. Judul yang diajukan l’)\m-semjuan
Analisis Soal Tes Belajar Siswa Dalam Pemebelajaran M 14
1 | Matematika Pada Bilangan Cacah Kelas IV di SD Negeri . N\ov
104218 Sidomulyo R\

Analisis Kemandirian Belajar Siswa Kelas IV Pada
2 | Materi Pelajaran Operasi Pencampuran di SD Negeri

104218 Sidomulyo
Pengaruh Mode Pembelajaran Problem Based Leaming,f U
3 | Terhadap Motivasi Belajar Siswa Pada : Materi
Matimatika Operasi Pencampuran di SD Negeri 104218
Sidomulyo {
Demikian permohonan ini disampaikan untuk pemeriksaan selanjutnya. Atas perhatian Bapak/ Ibu
diucapkan terimakasih.
Hormat pemdhon,
2
(Riza Wita Panjaitan)
|
E &
| pitengan :
buat rangkap 3 : - Asli untuk fakultas e
- Duplikat untuk Ketua Proct
Catay - Triplikat untuk arsip yang bersangkutan.
an ;

Paraf gan tanda ACC Ketua Program Studi pada Iajur judul yang disetujui dan silang pada lajur yang ditolak.

Rangkap 3

A




image26.jpeg
€p/1936 dan SK. o,

* 181/DIKTI/Kep/2002
uhammad Yones Kerim  J Garu l Mo 02.
ungen Desa Suka Mandi i Kee: Pager Merbee

MNaW.ac.id Email : info@umnaw.ac.id

— FORM. F. 2

meﬂlmd Arsyad I:-uh Lubis - J, Gary

No. 33 Kampus i

aru  No. 52 Meap, & iddin : are

Telp. (061) 7867044 Medan 20147 :l“:r:i‘l”ladg‘t"?:t: !/ﬂfr::h
+htep:, ur

PERSETUJUAN JUDUL SKRIPSI
Nomor : P/UMNAW/A.39/2024

Kepada
Saudara :Riza Wita Panjaitan
Tempat, Tgl.Lahir  : Loby Rampah, 21 April 2001
Program Studi : Pendidikan Guru Sekolah Dasar
Fakultas : Keguruan dan Ilmu Pendidikan

Setelah mempertimbangkan usulan judul/topik skripsi yang telah sauc!afa ajukan tanggal 15 Februari
2024 maka pihak fakultas berketetapan untuk memutuskan judul penelitian saudara :

Analisis Soal Tes Belajar Siswa Dalam Pembelajaran Matematika Pada Bilangan Caca di SD

|

\

|

|

NPM 1201434224
’ Negeri 104218 Sidomulyo

j dimis ipsi. Disampaikan bahwa, judultopik

ta agar saudara menyusun proposal skn.psn. fulito

S‘:rl;fld“ll:ll d};?at dise‘:npuingﬂkan dengan persetujuan kedua pembimbing, selama secara substansial tidak
dirubah .

Medan, 15 Februari 2024
Ketua Jurusan / Ketua Prodj

Sujarwd, S.Pd., M.Pd
b, 5.Pd. M.EM2t NIDN: 0117128103
NIDN: 011 11 38101
Tc"‘b"san:
Asli untuk mahasiswa
- Copy pertinggal untuk fakultas

Rangkap 2

il





image27.jpeg
Ka dan SK. No. ;
mjus "m-d':m’q Tl ks s WMo 53 e g <P/ 2002
<L Do, 52 Mdan Ko o ohamtad Yonus Kari . Gara i No. (7,

Tel, ®
elp. (061) erliaungn Desa Suka Wands Wil Ket: Pagar Merbau. Lubok Pakon

7867044 Medan 201,
a7 baga
Hame Page W-umnaw ac.id Email ; Info@umnaw, ac Id

+ http:/fww

FORM. F. 3

Hal

2 UMNAWFRIP /A 312024
: Satu set proposal

: Penghunjukan Pembimbing

Kepada Yth.
Saudara

Ibu Dra. Hj. Nurjannah, M.Si (Dosen Pembimbing)

di.-
Medan

Assalamu’alaikum Wr.Wb.
Dengan ini saudara ditugaskan sebagai pembimbing dalam penyelesaian Proposal dan
Skripsi Saudara :

Nama : Riza Wita Panjaitan

NPM 1201434224

Jurusan/Prog.Studi  : Iimu Pendidikan/Pendidikan Guru Sekolah Dasar

Dengan Judul :

Analisis Soal Tes Belajar Siswa Dalam Pembelajaran Matematika Pada Bilangan Caca
di SD Negeri 104218 Sidomulyo

Selanjutnya dipersilahkan Saudara menelaah dan menyempurnakan isi Proposal dan Skripsi

tersebut. ) _ i
Khusus mengenai judul/topik Proposal dan Skripsi dapat dlscn?pumakan selama tidak keluar
dari substansi. Bimbingan dilakukan bab per bab dan draf ditulls_ oleh mahaS}swa. ,

Atas kesediaan Saudara membimbing mahasiswa kita tersebut diucapkan terima kasih,

Medan, 15 Februari 2024
/Vpekan,

vy |\
N i
*.'Dr."Abdul Mujib, $.Pd., M.PMat
NIDN: 0111038101

Tembygy, .
; Mahagiyq ybs,
A['|p ﬁikullﬂs

Bk &




image28.jpeg
FORM.F. 4

1. Nama
2. NPM

3. Jurusan/Prog. Studi

BERITA ACARA BIMBINGAN SKRIPSI

‘Riza Wita Panjaita
1201434224 . "

: FKIP/Pendidikan Guru Sekolah Dasar

& N ; :D::isis Soal Tes Belajar Siswa Dalam Pembelajaran
&21:?:;‘:-:;;: Bilangan Cacsh Kelas IV DI SD Negeri
2 ?:gm:tﬁiemik ll'))zsaen}:’:::glar:l::gh b~
Tanggal Materi Payt) Keterangan a
22-01-2024 | Bimbingan Judul 7 /{
07-02-2024 | Bimbingan Revisi Judul // Z
16-02-2024 | ACC Judul Q,
06-05-2024 | Bimbingan Proposal BAB I-III b
13-05-2024 | Revisi Proposal
16-05-2024 | ACC Proposal BAB I-III /
5-07-2024 |Bimbingan Revisi Proposal Setelah ¢
Seminar 0
28-10-2024 | Bimbingan Skripsi BAB IV dan V
18-11-2024 | Revisi BAB IV denV /%
0-12-2024 | ACC Skripsi
b TS

e

r. Abdul Mufiib, S.Pd., M.
NIDN. 0111038101

Japa— Dekan pada saat pengajuan

n s
@ acara bimbingan skripsi ini dit jtandatangani

25 ujian mega hijas. i unk dien
R anskripsi dan ata o
" paling lambat 14 hari set€

bstrak kepada panm
{ah ujian meja hijav- Rangkap 2




image29.jpeg
Si

UNIVERSITAS pmus

K No.: 424/pik)

Lim NUSANTARA AL WASHLIYAH

/Kep/1996 dan SK.

No. : 181/DIKTI/Kep/2002
shen Sy {- Yo § e S o3, K Mo Yonus o . Gor 1o, 02
- (961) 7867004 Medtan 20147 yenen 09 Jt Mdan Perkngan s Sk Mandi il Ke ogar Merban, Lubuk Pk
© Page : hitp:/ /www.umnaw.ac.id Email : Info@umnaw.ac.id
FORM. FU. 4
PE
Nolxlnsol:-'.l"UJUAN MENGIKUTI UJIAN
! ?)L/PAN/UMNAW/J.IS/ZOM
Setelah mempelajari kelengkapan berkag Saudara :
1. Nama ‘Riza Wi i
5 ta Panjaitan
2 i :
8 TemMpaL tanggal Lahir :Lobu Rampah, 21 april 2001
3. NP ) $201434224
4. Jurusan/Prog.Studi *IP/Pendidikan Guru Sekolah Dasar
5. Agama :Islam
Dinyatakan dapat mengikuti ujian pada :
. vas 20%5
Hari/tanggal :Sdaga T Janvar
Jam : s.d selesai
Dosen Penguji 1.Dra. Nurjannah, M.Si
2.Dinda Yarshal, S.Pd., M.Pd
3, Arrini Shabrina Anshor, S.Pd., M.Pd
Dosen Saksi / Pencatat ~ : Sujarwo, S.Pd., M.Pd
. i ebaik-baiknya.
Demikian persetujuan ini diberikan agar dapat dilaksanakan s Y
Meédan, ... coonsaviiiini 2024

/JSekretaris / Dekan

D\

Dr. Abdul|Mujib, S.Pd., M.PMat
NIDN: 01311038101

Rangkap 2





image30.jpeg
o TN ey s T SRR
" A UNIVE
RSITAS MUSLIM NysaNTARA AL WASHLIYAH

SK. No. : 42
- : 424/DIKTI/Ke
Kep/1996 dan sK. No. : 2
Kampus Abdurrahman Syihah Arsyad Th n SK. No. : 181/DIKTI/Kep/200:
T . Garu  No. 57 n:tt':h 1B 1 No. 53, Kampus Muharmmad Yorus Kari  JI.Garo 11 o, 02,
9. (061) 7867008 Miectan gk A2 I W ey Desa ok Mnd i o Pagar Merba Lok Pk
lome Page : http://www.umnaw.ac.id Email : info@umnaw.ac.id

_— FORM. FU. 5
. UNDANGAN
omor : ?,1, /PAN/UMNAW/U.15/2024
Kepada Yth.
: Bapak”lbu: .......................
i Dosen Penguji
Di
Tempat.
Assalamualaikum Wr.Wb.
} Dengan hormat, kami mengundang Bapak/Ibu untuk menguji mahasiswa :
| Nama :Riza Wita Panjaitan
Tempat, tanggal Lahir  : Lobu Rampah, 21 April 2001
NPM :201434224 %
Jurusan/Prog.Studi : IP/Pendidikan Guru Sekolah Dasar
Agama :Islam

\-mg-lnsya Allah, akan diselenggarakan pada :
Hari / Tanggal . Celosa 3 wari 2025
Jam =

Judul Skripsi :

knalisis Soal T

Bilangan Cacah Kelas IV di SD Negeri 104

es Belajar siswa Dalam Pembelajaran Matematika Pada

218 Sidomulyo Z;.f’

\
' Terimakasih atas kehadiran Bapak/Ibu-
Medan, ....

/Sekretaris / Dekan

S V=
pr. Abdul [’\l_j?S.Pd., M.PMat

NIDN: 0113038101

§ Z
oN: 6167107101
1
by . e
;Rf’“‘” ‘ 5, Ketua Progra™ ol
3 :"‘ﬂ Rektor | 6. Ka. BAU .
¢ y il Rektor 1t 7. Ka. BAA
il Rektor 111 g, TU Fakulta$




image31.jpeg
UNIVERSITAS vy

SK. No. ; 424/pigTy
Arsyad Tha

LIM NUSANTARA AL WASHLIYAH

M{f:l’/l!?% dan SK. No. : 181/DIKT)/Kep/2002
Baru o, 52 Mg 3 52 . 53, Ko Mok Yorus Kari . Gara . 02 2
Aaiddin : J, Medan Parbaungan Desa Suka Mandi Hiir Kec. Pagar Marbou, Labuk Foliam

age : http://www.umnaw.ac.id Email : info@umnaw ac.id

FORM. FU. 6

KSPEDISI UNDANGAN UJIAN SARJAN.

“KSPEDISI UNDANGAN UJIAN SARJANA

E
NAMA ‘Riza Wita Panjaitan
NPM 1201434224

FAKULTAS :KIP

JURUSAN

¥

PROGRAM STUDI : PGSD

) ‘2) TU Fakultas i
 Penyampaian undangan menjadi
tanggung jawab mhs yang besangkutan-

TANGGAL
No. Disampaikan Kepada Tanggal | TandaT: Keterangan
Diterima Pe

01 | Dra. Nurjannah, M.Si / // 2

02 | Dinda Yarshal, S.Pd., M.Pd —=

03 | Arrini Shabrine Anshor, S.Pd., W.pa| 0/, 25 | ] -

-

% | Detan oo | 4

05 Ka. Program Studi U!).

% | TU Fakultas Ao ‘4} .

Biodata Wisuda terlampir
Y | Kepala Biro Adm. Akademik l@p P
A -01-2025 g‘%

m Kepala Biro Adm. Umum 050

09 : I Biodata Wisuda terlampir
| | Kepala Biro Adm. Kemahasiswaan ¢ ¥

10 Xs. 2 % /

11

12

LN i e oA T

13 :

14

Medatis oo spohitivissave s 2088
an. Panitia
Kabag Ujian
Nelly Tridawati Pohan, S.Kom

Catagay ; :
! Dibuay rangkap 2 masing-masing untuk :

! Kabag Ujian BAA

Ranghap 2





image32.jpeg
T— —— S T e i ——

UNIVERSITAS MUSLIM NUSANTARA AL WASHLIYAH

SK. No. : 424/DIKT1/Kep/1996 dan SK. No
181/DIKTI/Kep/2002
Nampus Moo Areyod Thal Libis 1 Garw | Mo 53 Karpus Muharend Yorus Rarin ) Gary 1 N 02

Aampus Abdurrshenan 2
‘*Nﬂ  Barw Mo 52 Medan Kampus Azl 1 Modan Porbaungan Desa Suka Mandh Hilke Kee: Pagar Marbau, Lubuk Pakam
{061) 7867044 Modan 20147 Home Page * Mtp //www umnaw ac id Email info@umnaw ac id

FORM. FU. 9

Nomor :

Pada hari ini S““‘ tanggal 1
bertempat  di ruang yu
Universitas Muslim

PANUMNAW/A 112025
bulan Jan tahun 2029

sium Universitas Muslim Nusantara Al Washliyah, panitia ujian sarjana
isantara Al Washliyah setelah :

Membaca - dsb.
Mendengarkan - dsb.
Memperhatikan - dsb.
Menimbang - dsb.
Memutuskan bahwa, Saudara :
Nama :Riza Wita Panjaitan
Tempat, tanggal Lahir :Lobu Rampah, 21 April 2001
NPM 1201434224
Fakultas : FKIP
Jurusan Prog.Studi :IP/Pendidikan Guru Sekolah Dasar

Dinyatakan : LULUS / HOAKHUHEUS

g o

Dengan skor / nilai ....... l" 7 ........ . Dan yudisium

Penguiji
|. Dra. Nurjannah, M.Si

2 Dinda Yarshal, S.Pd., M.Pd

3. Arrini Shabrina Anshor, S.Pd., M.Pd

Sujarwo, S.Pd., M.Pd
Ketua Program Studi

/ An. Rektor Medan, 7.2 2026
Jakil Rektor | Sekretaris / Dekan

Mg jage' \ ad
prof. Dr. hnwar Sadat Harahap, S.Ag., M. Hum Dr. Abdul Myjib,
NIDN:0107107101 NIDN:01110F8101

S.Pd., M.PMat

Rangkap 3





image33.jpeg
1L

LIS

IDENTITAS DIRI

Nama

NPM

T

Jenis Kelamin
Agama

Alamat

No TelpHpP

Dosen Pembimbing
Judul Skripsi

BIODATA MAHASISWA

: Riza wita panjaitan

1201434224

: Lobu Rampabh, 21 april 2001

: Prempuan

< Islam

: Lobu Rampah

: 082273528808

: Dra, Nurjannah.M.Si

: Analisis Soal Tes Belajar Siswa Dalam Pembelajaran

Matematika Pada Bilangan Cacah Kelas IV Negeri 104218 Sidomulyo

PENDIDIKAN

SD
SLTP/SMP
SLTA/SMA
S-1

ORANG TUA

Nama (Ayah)
Pekerjaan
Nama (Ibu)
Pekerjaan
Alamat

: SD NEGERI 114353 LOBU RAMPAH

: MTSS AL WASHLIYAH MARBAU

: MAS AL - WASHLIYAH MARBAU

: Universitas Muslim Nusantara Al Washliyah

:A. Syahlan Panjaitan
: Karyawan
: Mashana Dewi Marpaung

Lobu Rampah

Medan, Mei 2025
Hormat Saya

o

<

Riza wita panjaitan




image34.jpeg




image35.jpeg
1L

LIS

IDENTITAS DIRI

Nama

NPM

T

Jenis Kelamin
Agama

Alamat

No TelpHpP

Dosen Pembimbing
Judul Skripsi

BIODATA MAHASISWA

: Riza wita panjaitan

1201434224

: Lobu Rampabh, 21 april 2001

: Prempuan

< Islam

: Lobu Rampah

: 082273528808

: Dra, Nurjannah.M.Si

: Analisis Soal Tes Belajar Siswa Dalam Pembelajaran

Matematika Pada Bilangan Cacah Kelas IV Negeri 104218 Sidomulyo

PENDIDIKAN

SD
SLTP/SMP
SLTA/SMA
S-1

ORANG TUA

Nama (Ayah)
Pekerjaan
Nama (Ibu)
Pekerjaan
Alamat

: SD NEGERI 114353 LOBU RAMPAH

: MTSS AL WASHLIYAH MARBAU

: MAS AL - WASHLIYAH MARBAU

: Universitas Muslim Nusantara Al Washliyah

:A. Syahlan Panjaitan
: Karyawan
: Mashana Dewi Marpaung

Lobu Rampah

Medan, Mei 2025
Hormat Saya

o

<

Riza wita panjaitan




image36.jpeg




image5.jpeg
ABSTRACT

ANALYSIS OF STUDENTS’ TEST QUESTIONS IN MATHEMATICS
LEARNING ON WHOLE NUMBERS IN GRADE IV
AT SD NEGERI 104218 SIDOMULYO

RIZA WITA PANJAITAN
NPM. 201434224

The objective of this research was to determine the validity, reliability, difficulty
level, discriminating power, and distractor effectiveness of 15 multiple-choice
mathematics questions on whole numbers for Grade IV students at SDN 104218
Sidomulyo. This research employed a quantitative descriptive method. The
population consisted of 42 students, while the sample included 23 students. The
research instrument was a set of 15 multiple-choice mathematics questions on
whole numbers for Grade IV. Data analysis was conducted using SPSS Software
and Microsoft Excel.

The research findings indicate that 5 questions (33.3%) were valid, while 10
questions (66.7%) were invalid. The test instrument scored < 0.6, making it
unreliable. All 15 questions had a moderate difficulty level. The discriminating
power of the test items varied, with 4 questions classified as very poor, 6 questions
as poor, 3 questions as fair, and 2 questions as good. Regarding the effectiveness
X rs, only a few items required revision, and only one option was

Reliability, Discriminating Power, Distractor Effectiveness,
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Yalidasi Instrumen Soal Dan Jawaban

A. Tujuan

Tujuan penggunaan instumen ini adalah untuk menentukan skor dari kunci jawaban soal dan
mengetahui kesesuaian konsep, prosedur dan operasi yang ada pada kunci jawaban.

B. Petunjuk
1. Melalui instumen ini, Bapak/Ibu diminta untuk memberikan skor pada setiap kunci
jawaban yang telah dibuat.

2. Skor yang diberikan boleh berbeda, sesuai dengan tingkat kesulitan soal.

3. Skor maksimal pada setiap butir soal adalah 4.

4. Skor maksimal yang diberikan dari semua kunci jawaban (25 soal) adalah 100.

5. Bapak/Ibu diminta untuk memberikan saran/perbaikan serta Kesimpulan apakah soal
layak digunakan sebagai instumen penelitian atau tidak di bagian yang telah
disediakan.

No Soal Dimensi Kunci Jawaban
1. | Hasil dari 39.700 + 63.799 -49.999 ... | CI, C2 | Langkah-langkah:
a. 53500 c. 14500 Jumlahkan 39.700 dan 63.799
b. 10500 d. 20500 terlebih dahulu:
39.700 + 63.799 = 103.499
Kemudian, kurangkan 49.999
Skor: .. dari hasil di atas:
103.499 — 49.999 = 53.500
Jadi, hasil dari
39.700+63.799-49.999 adalah
53.500 (a)
2. | Bentuk persen dari;ﬁadalah s CL.C2 | Untuk mengubah pecahan 73—"
a. 15% c.20% menjadi bentuk persen, kita
b. 10% d. 16% kalikan  pecahan  tersebut
dengan 100.
3 e 3__0“ -’
. 7—08100— >0 = 15%
K Jadi, bentuk persennya adalah
15% (a)
3. | Bentuk peﬁ;i]ﬂll desimal dari ;—2 | CLC2 | Unuk Tnel\gubal\ pecah&;n ;—'3‘
adalah... menjadi bentuk desimal, kita
a. 0,65 c. 6,05 bagi pembilang (13) dengan
b. 0,605 d. 60,5 penyebut (20):
[ 130 - 0,65
. \; &
Skor : T
LI
L - i
J Jadi, _ bentuk _desimalnya |





image10.jpeg
["adalah 0,65 (a)

4. | Tanda perbandingan dari pecahan g C1,C2 | Untuk  membandingkan 5
dengan 63% yang tepat adalah . . dengan  63%, kita perlu
a. > c. < mengubah keduanya ke
b. = d.< bentuk yang sama, baik dalam
bentuk desimal atau persen.
« Pecahan 3= dalam bentuk
Skor : desimal yaitu 0,65. bentuk
persen, 0,65 = 65%
« Nilai yang kedua adalah
63%.
Sekarang kita bisa
membandingkan: 65% > 63%
Jadi, tanda perbandingan yang
tepat anmm% dan 63% adalah
lebih besar (>) (a)

5. | 38% dari siswa kelas V adalah C1,C2 | Untuk mengubah 38% ke
perempuan. Jika ditulis ke dalam dalam bentuk desimal, kita
bentuk desimal adalah . . . membagi 38 dengan 100:

a 38 €.0,038 38% === 0,38

100 pg
b, 038 40,0038 Jadi, 38% dalam bentuk
Skors desimal adalah 0,38 (a)

6. | Hasil penjumlahan dari 43 + 2 adalah | €1.C2 [ Untuk menjumlahkan 42+

. kita ikuti langkah-langkah
a. 4% c. 4% berikut: 4% ubah  menjadi
b 4% d.at pecahan biasa menjadi 3.

Kemudian,
LR R e
Skor: ... 2 6 < c
' e O PV E
3
Maka deiperoleh 4 (b)

7. | Hasil penjumlahan dari 0,75 - 27% C1,C2 | Ubah ke bentuk pecahan

adalah.... biasa:
a 4,08 c.04,.8 Dac=atc o =2
b. 48,0 d.0,48 _—
—_— e
.____:\L_a_ml_’
Skor : ... . & =
Maka diperoleh 0,48 (d)
8. | Hasil pengurangan dari 0,540 - 0,3 C1, C2 | Gunakan cara bersusun

adalah....
a. 0240, ¢. 0,240

kebawah dengan tanda koma
sejajar:





image11.jpeg
b. 02,40 d. 0,402

Skor :

01540
03 -
0,240 _-
Maka diperoleh 0,240 (c)

9. | Hasil dari > x 12X adalah . .. Cl1, C2 | Ubah terlebih dahulu pecahan
i | 5 A campuran ke pecahan biasa:
a 3 c By s, -
i % e
b 3 d. o .
5
Skor : Maka diperoleh g (a)
10. | Hasil dari 45% : 6/7 adalah . . . C1,C2 | Ubah  masing-masing ke
a. 0525 c. 0,525 desimal:
b. 052,5 d. 525
Skor :
Maka diperoleh 0, 525 (c)
11. Perb:;nfi;ngan 5/4 senilaisv.lesngan .- | C2,C3 | perbandingan ; senilai dengan
;:' ]0' o4 ; 16 .8 pecahan lainnya dapat
. . e ditemukan dengan mengalikan
pembilang dan penyebutnya
. dengan angka yang sama.
SKOF 3 Mengalikan dengan 2:
sx2 _ 10 - .
o= maka diperoleh 10: 8
@
— — |
12. | Taksiran dari 632 + 486 kira-kira ... C3 | Jumlahkan kemudian
a 900 '’ c.1.100 taksirl
b. 1.000 d. 1.200
Skor : ... -
U Taksiran terdekat adalah 1.100
©
13. | Hasil perkalian 24 dan 75 jika Cc3 e Iy
dibulatkan ke ribuan terdekat menjadi.. |LoEE |
a. 1.000 ¢.3.000 120
b. 2.000 d. 4.000 [N
Taksiran terdekat adalah 2.000

(b)





image12.jpeg
1412567241250~ . €3 [ Jumlahkan kemudian |
Taksiran dalam ratusan terdekat dari taksirlah:
operasi hitung di atas adalah ... LA
a. 26.800 €.26.000 o
b. 27.800 d.27.000 JRUFOTPE
1922
Skor : Taksiran  ratusan  terdekat
adalah 27.000 (c)
15 | Hasil pengurangan dari 1.578 dari C3 | Kurangkan kemudian
5.342 jika dibulatkan ke ratusan bulatkan:
terdekat menjadi.... €. 542
a. 3.700 ¢.3.000 EE
b. 3.800 d. 4.000 e =
3. 764
Skor: ... Pembulatan ke  ratusan

terdekat adalah 3800 (b)

Medan,
Validator Penilai

@% w*“?/l»

Oktober 2024
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Validasi Instrumen Soal Dan Jawaban

A. Tujuan

Tujuan penggunaan instumen ini adalah untuk menentukan skor dari kunci jawaban soal dan
mengetahui kesesuaian konsep, prosedur dan operasi yang ada pada kunci jawaban.

B. Petunjuk

Jjawaban yang telah dibuat.

Melalui instumen ini, Bapak/Ibu diminta untuk memberikan skor pada setiap kunci

2. Skor yang diberikan boleh berbeda, sesuai dengan tingkat kesulitan soal.

3. Skor maksimal pada setiap butir soal adalah 4.

4. Skor maksimal yang diberikan dari semua kunci jawaban (25 soal) adalah 100.

5. Bapak/Ibu diminta untuk memberikan saran/perbaikan serta Kesimpulan apakah soal
layak digunakan sebagai instumen penelitian atau tidak di bagian yang telah
disediakan.

No Soal Dimensi Kunci Jawaban
1| Hasil dari 39.700 + 63.799 -49.999 ... | C1, C2 | Langkah-langkah:
a. 53500 c. 14500 Jumlahkan 39.700 dan 63.799
b. 10500 d. 20500 terlebih dahulu:
39.700 + 63.799 = 103.499
Kemudian, kurangkan 49.999
Skor : dari hasil di atas:
103.499 — 49.999 = 53.500
Jadi, hasil dari
39.700+63.799-49.999 adaldh
53.500 (a)
2. | Bentuk persen dari %adalah . CLC2 | Untuk mengubah pecahan 2—3“
a 15% €. 20% menjadi bentuk persen, kita
b. 10% d. 16% kalikan  pecahan tersebut
dengan 100.
3 300
Skor: ... .. 2—“)(100:;:15%
Jadi, bentuk persennya adalah
15% (a)
3. | Bentuk pecahan desimal dari % CL C2 | yntuk mengubah pecahan %
adalah... menjadi bentuk desimal, kita
a. 0,65 c. 6,05 bagi pembilang (13) dengan
b. 0,605 d. 60,5 penyebut (20):
120 _
Skor: ... B e
B o=
| T e

o 4
Jadi, bentuk desimalnya |





image14.jpeg
[ Tadalah 0,65 (a)
Tanda perbandingan dari pecahan 2 | CL C2 | gk membandingkan =
dengan 63% yang tepat adalah . . dengan  63%, kita perlu
a > c.< mengubah  keduanya ke
b = d < bentuk yang sama, baik dalam
bentuk desimal atau persen.
13
Skor s . Pec-ahan 3 dalam bentuk
desimal yaitu 0,65. bentuk
persen, 0,65 = 65%
« Nilai yang kedua adalah
63%.
Sekarang kita bisa
membandingkan: 65% > 63%
Jadi, tanda perbandingan yang
tepat antara % dan 63% adalah
lebih besar (>) (a)
38% dari siswa kelas V adalah C1,C2 | Untuk mengubah 38% ke
perempuan. Jika ditulis ke dalam dalam bentuk desimal, kita
bentuk desimal adalah . . . membagi 38 dengan 100:
a 38 c. 0,038 38% = 22 = 0,38
00
b. 0,38 d. 0,0038 Jadi, 38% dalam bentuk
Skors . desimal adalah 0,38 (a)
Hasil penjumlahan dari 4% + Zadalah | CLC2 | Untuk menjumlahkan 4i+l
kita ikuti langkah-langkah
42 c.4% berikut: 43 ubah menjadi
§ d. 43 pecahan  biasa menjadi %.
Kemudian,
VRN R
Skor : A
[E— L B
e 2
Maka deiperoleh ‘lj (b)
Hasil penjumlahan dari 0,75 - 27% C1,C2 | Ubah ke bentuk pecahan
adalah.... bias:
a. 4,08 c. 04,8
b. 48,0 d. 0,48
="
Skor: ... Z BT 00,05
Maka diperoleh 0,48 (d)
Hasil pengurangan dari 0,540 - 0,3 C1,C2 [ Gunakan  cara  bersusun
adalah.... kebawah dengan tanda koma
a,_024,0 ¢. 0,240 | sejajar:
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14, 25'6?2 +1250= . C3 | Jumlahkan kemudian
Taksiran dalam ratusan terdekat dari taksirlah:
operasi hitung di atas adalah ... FISNED =)
a. 26.800 ©.26.000 rm—“‘T—-—-;;
b. 27.800 d.27.000 A v |
Fal(Eg 229
Skor : Taksiran  ratusan terdekat
adalah 27.000 (c)
15. | Hasil pengurangan dari 1.578 dari C3 | Kurangkan kemudian
5.342 jika dibulatkan ke ratusan bulatkan:
terdekat menjadi.... C.542
a. 3.700 ¢.3.000 "TST‘)Q—
b. 3.800 d. 4.000 ———
3.304
Skor: .. ... Pembulatan ke  ratusan
terdekat adalah 3800 (b)
Saran/Perbaikan :
An»«mc: e / 3 N a.,wt_o.
ge_;.- aukm 4&:3@ m:-m 7""5 o\k‘». »Luw

Kesimpulan:

L Paxe | Mgunaken | Soeml bat Cusaepa G

Medan,  Oktober 2024
Validator Penilai
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